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การเขา้สูร่ะบบ 
1. ดับเบิล้คลกิไอคอน Aspen  

 
2. จะปรากฎหนา้ตา่ง Enter Aspen Password ขึน้มาบนหนา้จอ 

 

3. พมิพร์หัสผา่นของทา่นในชอ่ง Password 

4. คลกิปุ่ ม OK 

การเปลีย่นรหสัผา่น 
1. จากหนา้ตา่ง Enter Aspen Password 

2. พมิพร์หัสผา่นปัจจบุนัของทา่นในชอ่ง Password 

3. คลกิใหม้เีครือ่งหมายถกู aหนา้ “Change your password”  

 

4. พมิพร์หัสผา่นใหมท่ีต่อ้งการในชอ่ง “New Password” และ “Verify Password” 

5. คลกิปุ่ ม OK 
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สว่นประกอบของหนา้จอ Aspen  

 

แถบเมนู 

แถบเมนูจะเปลีย่นไปตามฟังกช์นัทีแ่อคทฟี 

แถบเมนูเมือ่แอคทฟีทีฟั่งกช์นั Chart 

 

แถบเมนูเมือ่แอคทฟีทีฟั่งกช์นั News 
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แถบเครือ่งมอื 

 
 

 

 

แถบเครือ่งมอืฟงักช์นัหลกั 

 

การเรยีกเมนูยอ่ย 

คลิกปุ่ มขวาของเมา้ส์ เพื่อเรียกดูเมนูย่อยของแต่ละ

ฟังกช์นั หรอืเลอืกจากแถบเมนูดา้นบน 

ไอคอน รายละเอยีด 

 

Open Page เปิดหนา้เพจ 

 

Open Window เปิดหนา้วนิโดว ์ 

 Save Page บนัทกึหนา้เพจ 

 Save Window บนัทกึหนา้วนิโดว ์

 Print พมิพอ์อกทางเครือ่งพมิพ ์

 Copy คัดลอกขอ้ความ 

 Paste วางขอ้ความ 

 Clear Screen ปิ ดทุ กหน ้า ต่ า งบน

หนา้จอ ใหเ้ป็นหนา้วา่ง 

ไอคอน รายละเอยีด 

 Larger Font เพิม่ขนาดตัวอกัษร 

 Smaller Font ลดขนาดตัวอกัษร 

 Symbol List รายการ Symbol ทีใ่ชล้า่สดุ 

 Equity พอรต์โฟลโิอจ าลอง 

 Undo ยกเลกิค าสัง่ลา่สดุ 

 Redo ท าซ ้าค าสัง่ลา่สดุ 

 Themes เลอืกธมีส ี

ไอคอน รายละเอยีด 

 Chart กราฟ 

 Quote โควท 

 News ขา่ว 

 Thai News ขา่วภาษาไทย 

 SQ วนิโดวโ์ควทส าเร็จรปู 

ไอคอน รายละเอยีด 

 Time & Sales ขอ้มลูราคาเรยีงตามเวลา 

 Fixed Format ฟิกซฟ์อรแ์มต 

 Extension ขอ้มลูเสรมิ 

 Clock นาฬกิา 

 Price & Volume  
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การเปิดหนา้เพจ  
การเปิดหนา้เพจ (ไฟล:์ *.agp) ท าได ้3 วธิ ีดังนี ้

 คลกิปุ่ ม  Open Page แลว้ดับคลกิยงัชือ่หนา้เพจทีต่อ้งการ หรอื 

 

 พมิพช์ือ่หนา้เพจ แลว้กดปุ่ ม Enter หรอื 

 เพิม่หนา้เพจทีต่อ้งการ ไวใ้นปุ่ ม Shortcut Key (อา่นรายละเอยีดเพิม่เตมิหนา้ 55) 

การเปิดหนา้วนิโดวย์อ่ย 
การเปิดวนิโดวย์อ่ย(ไฟล:์ *.agw) ท าได ้3 วธิ ีดังนี ้

 คลกิปุ่ ม  Open Window แลว้ดับคลกิยงัชือ่หนา้วนิโดวท์ีต่อ้งการ หรอื 

 

 พมิพช์ือ่หนา้วนิโดว ์แลว้กดปุ่ ม Enter หรอื 

 เพิม่หนา้วนิโดวท์ีต่อ้งการ ไวใ้นปุ่ ม Shortcut Key (อา่นรายละเอยีดเพิม่เตมิหนา้ 55) 
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การก าหนดแอคทฟีวนิโดว ์

ทา่นสามารถสรา้งหนา้เพจทีม่หีลายๆ วนิโดวย์อ่ยประกอบกนัได ้การเลอืกแอฟทฟีวนิโดวท์ าไดโ้ดย  

 คลกิยงัวนิโดวท์ีต่อ้งการใหเ้ป็นแอคทฟีวนิโดว ์จะมกีรอบลอ้มรอบวนิโดวนั์น้ 
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หนา้เพจส าเร็จรปูทีใ่ชบ้อ่ย 

F6-Quote (ปุ่ ม F6) 

แสดงขอ้มลูดัชนีตลาดหุน้ทีส่ าคัญทั่วโลก ขอ้มลูฟิวเจอรส์ตลาดต่างประเทศ อัตราแลกเปลีย่นเงนิต่างประเทศ 

อตัราดอกเบีย้ ราคาสนิคา้โภคภณัฑต์ลาดตา่งประเทศ เชน่ น ้ามนั ทองค า เงนิ ถา่นหนิ โลหะพืน้ฐาน  

ใชส้ าหรับตดิตามภาวะตลาดทั่วโลกในทกุๆ ตลาดในหนา้จอเดยีว แกร้ปูในหนา้ F6 ** ขอ้มลูบางตัวตัดออก >> 

Pic: 001-A4W - F6-Quotes หนา้ 9 

 

 เปิดหนา้เพจนี ้ได ้3 วธิ ีดังนี ้

» กดปุ่ ม F6 บนคยีบ์อรด์ หรอื 

» คลกิปุ่ ม  Open Page > Equity > F6-Quote หรอื 

» พมิพ ์F6-Quote บนหนา้ตา่งใดก็ได ้แลว้กดปุ่ ม Enter 

 เรียกดูกราฟของขอ้มูลที่ตอ้งการได ้โดยการดับเบิล้ที่ขอ้มูลของ Symbol นั้นๆ จะปรากฏวนิโดว์กราฟ 

(QCHART) ขึน้มาบนหนา้จอ  
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 หนา้นีแ้บง่เป็น 6 สว่น โดยมรีายละเอยีด ดังนี ้

สว่นที ่1: ดชันตีลาดหุน้ตา่งประเทศ  

แสดงขอ้มลูดัชนตีลาดหุน้ทีส่ าคัญทั่วโลก แบง่กลุม่ตามทวปีอเมรกิา เอเชยี และยโุรปตามล าดับ  

» ทวปีอเมรกิา เชน่ Dow Jones, NASDAQ 100, S&P 500 เป็นตน้ 

» ทวปีเอเชยี เชน่ Nikkei (ญีปุ่่ น), Hang Seng (ฮอ่งกง), Strait Times (สงิคโปร)์ เป็นตน้ 

» ทวปียโุรป เชน่  FTSE100 (องักฤษ), DAX (เยอรมน)ี, CAC40 (ฝร่ังเศส) เป็นตน้ 

สว่นที ่2: ขอ้มลูฟิวเจอรส์ดชันตีลาดหุน้และราคาน า้มนั  

» ดัชนตีลาดหุน้ฟิวเจอรส์ทีส่ าคัญ ไดแ้ก ่Dow Jones, NASDAQ 100, S&P 500 

» ราคาน ้ ามันในตลาดฟิวเจอร์ส ICE ไดแ้ก่ น ้ ามันดิบ (Crude Oil), น ้ ามันเตา (Heating Oil) และ

น ้ามนัดบิเบรนท ์(Brent Crude) 

» ดัชนนี ้ามนัดบิเบรนท ์(ICE Brent Index) 

สว่นที ่3: ขอ้มลูโลหะมคีา่, คา่ระวางเรอื, ราคาถา่นหนิ  

» ราคาทองค าในประเทศจากสมาคมผูค้า้ทองค า 

» ราคาทองค าและแรเ่งนิในตลาดสปอตและตลาดฟิวเจอรส์ COMEX 

» ราคาแพลทนัิมและพาลาเดยีมในตลาดฟิวเจอรส์ NYMEX 

» ดัชนคีา่ระวางเรอื (Baltic Dry Index) 

» ราคายางในตลาดฟิวเจอรส์ TOCOM  

» ราคาถา่นหนิทีท่า่เรอื Newcastle ออสเตรเลยีในตลาดฟิวเจอรส์ ICE 

สว่นที ่4: ขอ้มลูการซือ้ขายตามกลุม่นกัลงทนุ และหุน้ไทยทไีปเทรดในตลาดหุน้ตา่งประเทศ  

» ขอ้มลูการซือ้ขายสทุธแิยกตามกลุ่มนักลงทุนในตลาด SET โดยมทีัง้แบบรายวัน, สะสมแบบ Month to 

Date (MTD) และสะสมแบบ Year to Date (YTD) 

» หุน้ไทยทไีปเทรดในตลาดหุน้ตา่งประเทศ  

Symbol ชือ่บรษิทั รายละเอยีด 

Y92’SG Thai Beverage  หุน้ไทยเบฟเวอเรจ ในตลาดหุน้สงิคโปร ์

DU4’SG Mermaid Maritime หุน้บรษัิทลกูของ TTA ในตลาดหุน้สงิคโปร ์

สว่นที ่5: ราคาโลหะพืน้ฐานในตลาด LME และตลาดฟิวเจอรส์ 

» ราคาโลหะพืน้ฐานในตลาด LME เชน่ อลมูเินยีม, ทองแดง, ตะกัว่, เหล็กแปรรปู, เศษเหล็ก เป็นตน้ 

» ราคาโลหะพื้นฐานในตลาดฟิวเจอร์ส NYMEX เช่น เหล็กแผ่นรีดรอ้นชนิดมว้น (Hot Rolled Coil), 

ทองแดง 

สว่นที ่6: ดชันคีา่เงนิดอลลารส์หรฐั, อตัราดอกเบีย้และอตัราแลกเปลีย่น 

» ดัชนคีา่เงนิดอลลารส์หรัฐ (US Dollar Index) 

» อตัราดอกเบีย้นโยบายของธนาคารกลางสหรัฐ (FED Fund) และ ธปท. (BOT Policy) 

» อตัราแลกเปลีย่นเงนิตา่งประเทศจาก ธปท. และอตัราแลกเปลีย่นในตลาดสปอต 

» อตัราดอกเบีย้ระหวา่งธนาคาร ไดแ้ก ่LIBOR (องักฤษ), SIBOR (สงิคโปร)์ และ BIBOR (ไทย) 
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F7-Chart (ปุ่ ม F7) 

แสดงกราฟของ Symbol ทีต่อ้งการ พรอ้มเครือ่งมอืเทคนคิวเิคราะห ์ 

 

 เปิดหนา้เพจนี ้ได ้3 วธิ ีดังนี ้

» กดปุ่ ม F7 บนคยีบ์อรด์ หรอื 

» คลกิปุ่ ม  Open Page > Chart > F7-Chart หรอื 

» พมิพ ์F7-Chart บนหนา้ตา่งใดก็ไดบ้นหนา้ แลว้กดปุ่ ม Enter 

 การเปลีย่น Symbol ท าไดโ้ดย พมิพ ์Symbol ทีต่อ้งการดูกราฟ แลว้กดปุ่ ม Enter เชน่ พมิพ ์SET ส าหรับ 

SET Index เป็นตน้ 

Commod-Summary (ปุ่ ม F2) 

แสดงขอ้มลูราคาสนิคา้โภคภัณฑท์ีส่ าคัญทั่วโลก ไมว่่าจะเป็นน ้ามัน ถ่านหนิ โลหะพืน้ฐาน ทองค า เงนิ น ้าตาล 

กาแฟ เป็นตน้ 

 

 เปิดหนา้เพจนี ้ได ้3 วธิ ีดังนี ้

» กดปุ่ ม F2 บนคยีบ์อรด์ หรอื 

» คลกิปุ่ ม  Open Page > Commod > Commod-Summary หรอื 

» พมิพ ์Commod-Summary บนหนา้ตา่งใดก็ไดบ้นหนา้ แลว้กดปุ่ ม Enter 
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F8-News (ปุ่ ม F8) 

รายงานขา่วเรยีลขา่วไทมแ์ละใหบ้รกิารขา่วยอ้นหลัง 6 เดอืน รายงานขา่วจากส านักขา่วชัน้น าทัง้ในประเทศและ

ตา่งประเทศ สรปุขา่วหนังสอืพมิพ ์ขา่วจากตลาดหลักทรัพย ์รวมถงึบทวเิคราะหจ์ากโบรกเกอร ์ 

 

 เปิดหนา้เพจนี ้ได ้3 วธิ ีดังนี ้

» กดปุ่ ม F8 บนคยีบ์อรด์ หรอื 

» คลกิปุ่ ม  Open Page > News > F8-News หรอื 

» พมิพ ์F8-News บนหนา้ตา่งใดก็ไดบ้นหนา้ แลว้กดปุ่ ม Enter 

F9-Fixed (ปุ่ ม F9) 

แสดงขอ้มลูอืน่ๆ โดยจัดกลุม่ขอ้มลูเป็นหมวดหมูต่า่งๆ ไดแ้ก ่ตลาดหุน้ ตลาดเงนิ ตัวเลขเศรษฐกจิ อตัราดอกเบีย้ 

เป็นตน้ พมิพห์มายเลขหนา้ทีต่อ้งการ แลว้กดปุ่ ม Enter เพือ่เรยีกดขูอ้มลู 

 

 เปิดหนา้เพจนี ้ได ้3 วธิ ีดังนี ้

» กดปุ่ ม F9 บนคยีบ์อรด์ หรอื 

» คลกิปุ่ ม  Open Page > FX and Money > F9-Fixed หรอื 

» พมิพ ์F9-Fixed บนหนา้ตา่งใดก็ไดบ้นหนา้ แลว้กดปุ่ ม Enter 
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ฟงักช์นักราฟ (Chart)  

ดกูราฟของ Symbol ทีต่อ้งการ พรอ้มเครือ่งมอืเทคนคิวเิคราะห ์และเสน้แนวโนม้แบบตา่งๆ  

 คลกิปุ่ มไอคอน  Chart บนแถบเครือ่งมอื เพือ่เปิดวนิโดวก์ราฟ (Chart) 

การเปลีย่นรปูแบบกราฟ (Chart Type) 

การเปลีย่นรปูแบบกราฟ ท าได ้2 วธิ ีดังนี ้

 คลกิปุ่ มไอคอน  Chart Type แลว้คลกิยังรูปแบบกราฟทีต่อ้งการจากเมนู โดยปุ่ มไอคอนจะเปลีย่นไป

ตามรปูแบบกราฟทีเ่ลอืก หรอื 

 

 พมิพค์ าสัง่ แลว้กดปุ่ ม Enter 

รปูแบบกราฟ ปุ่ มไอคอน ค าส ัง่ 

Bar Chart  .BAR 

Candlesticks  .CANDLE 

Point & Figures  .P&F 

Line Chart  .LINE 

ชนดิของเทคนคิวเิคราะห ์

เทคนคิวเิคราะหบ์น Aspen แบง่เป็น 2 กลุม่ คอื 

1. Overlay เทคนิควิเคราะห์ที่พลอตบนกราฟราคาหรือบนเทคนิควิเคราะห์อื่น เช่น Moving Average, 

Bollinger Bands, Parabolic SAR เป็นตน้  

 คลกิปุ่ มไอคอน  Add Overlay เพือ่เพิม่เทคนคิวเิคราะหช์นดินี้ 

2. Study เทคนิควเิคราะหท์ี่ไม่สามารถพลอตทับบนเทคนิควเิคราะห์อืน่ได ้และตอ้งเพิม่หนา้ต่างย่อยเพือ่

เรยีกดกูราฟเทคนคิวเิคราะหช์นดินี ้เชน่ MACD, RSI, Stochastics เป็นตน้ 

 คลกิปุ่ มไอคอน  Add Study to New Split เพือ่เพิม่เทคนคิวเิคราะหช์นดินีใ้นหนา้ตา่งยอ่ย 
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การเพิม่เทคนคิวเิคราะหแ์บบ Overlay 

1. คลกิปุ่ มไอคอน  Add Overlay หรอืคลกิเมา้สข์วาแลว้เลอืก Add Overlay 

2. คลกิเลอืกเทคนคิวเิคราะหท์ีต่อ้งการ เชน่ Moving Average  

 

3. เทคนคิวเิคราะห ์Moving Average จะถกูเพิม่ในกราฟ 

 

การเพิม่เทคนคิวเิคราะหแ์บบ Study ในหนา้ตา่งยอ่ย 

1. คลกิปุ่ มไอคอน  Add Study to New Split  

2. คลกิเลอืกเทคนคิวเิคราะหท์ีต่อ้งการ เชน่ Directional Indicator  
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3. เทคนคิวเิคราะห ์Directional Indicator จะถกูเพิม่ในหนา้ตา่งยอ่ย 

 

การเปลีย่นเทคนคิวเิคราะหใ์นหนา้ตา่งยอ่ย 

1. คลกิเมา้สข์วายังหนา้ต่างย่อยทีห่นา้ต่างย่อยทีต่อ้งการเปลีย่นเทคนคิวเิคราะห ์ เพือ่ท าใหห้นา้ต่างนัน้เป็น
หนา้ตา่งทีแ่อคทฟี (จะมกีรอบลอ้มรอบ) เชน่ ตอ้งการเปลีย่นจาก MACD เป็น RSI  

 

2. คลกิปุ่ มไอคอน Replace Study หรอืคลกิเมา้สข์วาแลว้เลอืก Replace Study 

3. เลอืกเทคนคิวเิคราะหท์ีต่อ้งการจากเมนู เชน่ Relative Strength Index 

 

4. เทคนคิวเิคราะหท์ีเ่ลอืก จะพลอตแทนทีเ่ทคนคิวเิคราะหก์อ่นหนา้นี ้ 
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การแกไ้ขพารามเิตอรข์องเทคนคิวเิคราะห ์

1. คลกิเมา้สข์วายังหนา้ตา่งยอ่ย ทีม่ใีสเ่ทคนคิวเิคราะหท์ีต่อ้งการแกไ้ขพารามเิตอร ์เพือ่ท าใหห้นา้ตา่งนัน้เป็น

หนา้ตา่งทีแ่อคทฟี (จะมกีรอบลอ้มรอบ) กอ่น 

2. คลิกเมา้ส์ขวาแลว้เลือก Parameters หรือ คลิกที่ปุ่ มไอคอน  Study Parameters จากแถบ

เครือ่งมอื 

 

3. เลอืกเทคนคิวเิคราะหท์ีต่อ้งการแกไ้ขจากเมนู เชน่ Moving Average 1 (Moving Average เสน้ที ่1) 

4. จะปรากฎหนา้ตา่งพารามเิตอรข์องเทคนคิวเิคราะหท์ีเ่ลอืกไวข้ ึน้มาบนหนา้จอ 

 

5. แกไ้ขพารามเิตอรท์ีต่อ้งการ  
6. คลกิปุ่ ม OK 

 หากตอ้งการตัง้ค่าพารามเิตอร์ใหเ้ป็นแบบที่ตอ้งการเสมอ หลังจากที่ก าหนดพารามเิตอร์ตามตอ้งการ

เรยีบรอ้ยแลว้ ใหค้ลกิปุ่ ม Save as Default 

การลบเทคนคิวเิคราะหแ์บบ Overlay 

1. คลกิเมา้สซ์า้ยยงัหนา้ตา่งยอ่ยทีม่เีทคนคิวเิคราะหท์ีต่อ้งการลบ เพือ่ท าใหห้นา้ตา่งนัน้เป็นหนา้ตา่งทีแ่อคทฟี 
(จะมกีรอบลอ้มรอบ) 

2. คลกิเมา้สข์วาแลว้เลอืก Remove Study ห รือ  คลิกปุ่ ม ไอคอน   Remove Study จากแถบ

เครือ่งมอื (หากตอ้งการลบทัง้หมด ใหค้ลกิปุ่ มไอคอน  Remove All Overlays) 

3. เลอืกเทคนคิวเิคราะหท์ีต่อ้งการจากเมนู  

4. เทคนคิวเิคราะหท์ีเ่ลอืกไว ้จะถกูลบออกไป 

การลบหนา้ตา่งยอ่ย 

1. คลกิเมา้สซ์า้ยยงัหนา้ตา่งยอ่ยทีม่เีทคนคิวเิคราะหท์ีต่อ้งการลบ เพือ่ท าใหห้นา้ตา่งนัน้เป็นหนา้ตา่งทีแ่อคทฟี 
(จะมกีรอบลอ้มรอบ) 

2. คลกิปุ่ มไอคอน  Remove Split  

3. หนา้ตา่งทีเ่ลอืกไว ้จะถกูลบออกไป 
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การเปลีย่น Time Frame หรอื Chart Interval 

การเปลีย่น Time Frame หรอื Chart Interval บนกราฟ ท าได ้3 วธิ ีดังนี ้

 โดยคลกิเลอืกจากปุ่ มไอคอน  Time Frame  หรอื  

 

 คลกิเมา้สข์วา Ą คลกิ Time Frame Ą คลกิเลอืก Time Frame ทีต่อ้งการจากเมนู หรอื 

 

 พมิพค์ าสัง่ แลว้กดปุ่ ม Enter 

 

การปรบัสเกลเวลา (แกน X)  

การปรับสเกลเวลา สามารถท าได ้3 วธิ ีดังนี ้

 คลกิเลอืกจากแถบเครือ่งมอืของกราฟ หรอื 

 

 คลกิปุ่ มคยีล์ัดบนคยีบ์อรด์ หรอื 

 ใชล้อ้หมนุของเมา้ส ์โดยเลือ่นเคอรเ์ซอรเ์มา้สไ์ปวางทีแ่กนเวลา 

  

Time Frame ค าส ัง่ 

Tick 0 

15 Minute 15 

รายนาท ี พมิพจ์ านวนนาททีีต่อ้งการ 

รายชัว่โมง 60 

ราย 4 ชัว่โมง 240 

Time Frame ค าส ัง่ 

Day DAY 

Week WEEK 

Month MONTH 

Quarter QUARTER 

Year YEAR 
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สิง่ทีต่อ้งการ ปุ่ มไอคอน ปุ่ มคยีล์ดั ลอ้หมนุของเมา้ส ์

บบีความกวา้งของ

แทง่กราฟ 
 

ปุ่ ม Delete กดลอ้หมนุของเมา้สค์า้งไว ้แลว้หมนุลอ้หมนุ

ลงดา้นลา่ง 

ขยายความกวา้งของ

แทง่กราฟ 
 

ปุ่ ม Insert กดลอ้หมนุของเมา้สค์า้งไว ้แลว้หมนุลอ้หมนุ

ขึน้ดา้นบน 

เลือ่นไปดแูทง่กราฟ

ทีอ่ยูด่า้นซา้ยมอื 
 

ปุ่ ม Ctrl+L หรอื 

พมิพค์ าสัง่ .LEFT 

หมนุลอ้หมนุขีน้ดา้นบน 

เลือ่นไปดแูทง่กราฟ

ทีอ่ยูด่า้นขวามอื 
 

ปุ่ ม Ctrl+R หรอื 

พมิพค์ าสัง่ .RIGHT 

หมนุลอ้หมนุลงดา้นลา่ง 

รเีซทสเกลเวลาให ้

เป็นคา่ Default 
 

ปุ่ ม Home ดับเบิล้คลกิเมา้สซ์า้ยทีแ่กน X 

การปรบัสเกลราคา (แกน Y)  

การปรับสเกลเวลา สามารถท าได ้3 วธิ ีดังนี ้

 คลกิเลอืกจากแถบเครือ่งมอืของกราฟ หรอื 

 

 คลกิปุ่ มคยีล์ัดบนคยีบ์อรด์ หรอื 

 ใชล้อ้หมนุของเมา้ส ์โดยเลือ่นเคอรเ์ซอรเ์มา้สไ์ปวางทีแ่กนราคา 

  

สิง่ทีต่อ้งการ ปุ่ มไอคอน ปุ่ มคยีล์ดั ลอ้หมนุของเมา้ส ์

ขยายความกวา้งของ

แกนราคา 
 

ปุ่ ม ą กดลอ้หมนุของเมา้สค์า้งไว ้แลว้หมนุลอ้หมนุ

ขึน้ดา้นบน 

บบีความกวา้งของ

แกนราคา 
 

ปุ่ ม Ć กดลอ้หมนุของเมา้สค์า้งไว ้แลว้หมนุลอ้หมนุ

ลงดา้นลา่ง 

เลือ่นกราฟขึน้ดา้นบน 
 

ปุ่ ม Page Up หมนุลอ้หมนุลงดา้นลา่ง 

เลือ่นกราฟลง

ดา้นลา่ง 
 

ปุ่ ม Page Down หมนุลอ้หมนุขีน้ดา้นบน 

รเีซทสเกลราคาให ้

เป็นคา่ Default 
 

ปุ่ ม Home ดับเบิล้คลกิเมา้สซ์า้ยทีแ่กน Y 
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รปูแบบของสเกลราคา 

 

สเกลราคาบน Aspen มใีหเ้ลอืก 3 รปูแบบ ดังนี ้

1. Linear ความกวา้งของชว่งราคาแตล่ะชว่งจะเทา่กนั โดยคดิจากคา่การเปลีย่นแปลง (Change) เทา่นัน้ และ

เป็นสเกลมาตรฐาน (Default) บนฟังกช์นั Chart  

 คลกิปุ่ มไอคอน  Linear บนแถบเครือ่งมอืของกราฟ หรอืพมิพค์ าสัง่ .LINEAR   

 

2. Log ความกวา้งช่วงราคาจะคดิเป็นแบบ % การเปลี่ยนแปลง (%Change) เมือ่ใชส้เกลแบบนี้จะมคี าว่า 

“Log” แสดงอยูบ่นมมุขวาบนของแกนราคา 

 คลกิปุ่ มไอคอน  Log บนแถบเครือ่งมอืของกราฟ หรอืพมิพค์ าสัง่ .LOG  

 

3. %Change ค านวณราคาในหน่วยเปอรเ์ซน็ตก์ารเปลีย่นแปลง เพือ่เปรยีบเทยีบราคาในแตล่ะวันกบัวันฐานที่

ก าหนดไว ้เมือ่ใชส้เกลแบบนีจ้ะมคี าวา่ “%Chg” แสดงอยูบ่นมมุขวาบนของแกนราคา 

 คลกิปุ่ มไอคอน  Percent Chg Scale บนแถบเครือ่งมอืของกราฟ หรอืพมิพค์ าสัง่ .PERCENT 

 

 เมือ่เปลีย่นเป็นสเกลแบบนี ้โปรแกรมจะก าหนดใหก้ราฟแทง่ซา้ยสดุของหนา้จอเป็นวันฐานเสมอ 
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 หากตอ้งการเปลี่ยนวันฐาน ใหเ้ลื่อนเสน้เคอร์เซอร์ไปไวย้ังวันที่ตอ้งการ แลว้คลิกปุ่ มไอคอน  

Percent Chg Scale  

 

การดกูราฟเปรยีบเทยีบหลายๆ Symbol แบบใชส้เกลราคารว่มกนั 

การดูกราฟเปรยีบเทยีบหลายๆ Symbol แบบใชส้เกลราคาร่วมกันนัน้เหมาะกบั Symbol ทีม่รีะดับราคาใกลเ้คยีง

กนั  สามารถท าได ้2 วธิ ีดังนี ้

1. ใสเ่ครือ่งหมาย “,” (คอมมา่) คั่นระหวา่ง Symbol เชน่ BBL,KBANK,SCB  แลว้กดปุ่ ม Enter หรอื 

 

2. คลกิปุ่ มไอคอน  Add Symbol to Chart พมิพ ์Symbol ทีต่อ้งการเพิม่เขา้ไป แลว้กดปุ่ ม Enter 
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การดกูราฟเปรยีบเทยีบหลายๆ Symbol แบบแยกสเกลราคา 

 

หากตอ้งการดูกราฟเปรียบเทียบหลายๆ Symbol ซึง่มสีเกลราคาที่แตกต่างกัน ใหใ้ชว้ธิีการเพิม่ Layer เพื่อ   

พลอตกราฟของแตล่ะ Symbol โดยใชส้เกลราคาทีแ่ยกเป็นอสิระจากกนั  

การเพิม่ Layer  

ตัวอยา่งเชน่ ตอ้งการเปรยีบเทยีบ KTB, TMB และ LHBANK 

1. คลกิปุ่ มไอคอน  Chart เพือ่เรยีกหนา้ตา่งกราฟใหมข่ึน้มาบนหนา้จอ 

2. พมิพ ์Symbol ตัวแรกทีต่อ้งการ แลว้กดปุ่ ม Enter เชน่ KTB 

 

3. คลกิปุ่ มไอคอน  Add Layer เพือ่เพิม่หนา้ตา่งกราฟแบบโปรง่ใสซอ้นทับดา้นบน  

4. พมิพ ์Symbol ตัวถัดไปทีต่อ้งการ แลว้กดปุ่ ม Enter เชน่ TMB 

5. ท าซ ้าขัน้ตอนที ่3-4 จนได ้Symbol ครบตามทีต่อ้งการ  

 

6. การเปลีย่น Layer ที ่Active ใหค้ลกิยงัชือ่ Symbol ทีต่อ้งการ 

7. หากตอ้งการเชือ่มทุกๆ Layer เขา้ดว้ยกนั ใหเ้ลอืกรูปแบบการซงิโครไนซ ์(Synchronize) ทีต่อ้งการจากปุ่ ม

ไอคอน  Synchronize Layer ซึง่มหีลายรปูแบบ ดังนี ้

 

ตวัเลอืก ความหมาย 

Lock Time Frames ก าหนดใหท้กุๆ Layer ใช ้Time Frame ตาม Layer ทีแ่อคทฟีอยู ่ 

Lock Price Scale ก าหนดใหท้กุๆ Layer ใชส้เกลราคาตาม Layer ทีแ่อคทฟีอยู ่

Lock Date/Time ก าหนดใหทุ้กๆ Layer ใชส้เกลเวลาและ Time Frame ตาม Layer ที่แอคทฟีอยู่ 

เมือ่เลอืกค าสั่งนี้ จะมเีครือ่งถูกหนา้ Lock Time Frames และ Lock Bar Spacing 

ดว้ย 

Lock Bar Spacing ก าหนดใหท้กุๆ Layer ใชค้วามกวา้งของตาม Layer ทีแ่อคทฟีอยู ่

Lock Study Type ก าหนดใหท้กุๆ Layer ใชร้ปูแบบกราฟตาม Layer ทีแ่อคทฟีอยู ่ 

Lock Symbols ก าหนดใหท้กุๆ Layer ใช ้Symbol ตาม Layer ทีแ่อคทฟีอยู ่ 
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การลบ Layer  

การลบ Layer ทีไ่มต่อ้งการ มขีัน้ตอน ดังนี้ 

1. คลกิเมา้สย์งั Layer ทีต่อ้งการลบ 

2. คลกิปุ่ มไอคอน  Remove Layer 

 

การก าหนดวนัทีเ่ร ิม่ตน้/วนัทีส่ ิน้สดุบนกราฟ 

ทา่นสามารถก าหนดวันทีเ่ร ิม่ตน้ หรอื วันทีส่ ิน้สดุบนกราฟ โดยพมิพค์ าสัง่ ดังนี ้

ก าหนด ค าส ัง่ ตวัอยา่ง 

วน้ทีเ่ริม่ตน้ .AFTER mm/dd/yy .AFTER 4/1/14 ก าหนดใหจ้ดุเริม่ตน้เป็นวันที ่1 Apr 2014 

วันทีส่ ิน้สดุ .BEFORE mm/dd/yy .BEFORE 6/30/14 ก าหนดใหจ้ดุสิน้สดุเป็นวันที ่30 Jun 2014 

     

การเปลีย่นสขีองกราฟตามเงือ่นไข (Color Rules) 

ท่านสามารถเปลีย่นสขีองกราฟตามเงือ่นไขทีต่อ้งการได ้ไมว่่าจะเป็นเงือ่นไขดา้นราคา หรอืเงือ่นไขทางเทคนคิ

วเิคราะห ์โดยมวีธิกีารท า ดังนี้ 

ตัวอยา่งเชน่ ถา้ Volume วันนีส้งูกวา่วันกอ่นใหเ้ปลีย่นสแีทง่กราฟเป็นสเีขยีว ถา้ไมใ่ชใ่หเ้ปลีย่นเป็นสแีดง 

1. คลกิยงัหนา้ตา่งยอ่ยทีม่ ีVolume เพือ่ใหเ้ป็นแอคทฟีวนิโดว ์

 

2. คลกิปุ่ มไอคอน  Study Parameters หรอืคลกิเมา้สข์วาแลว้เลอืก Parameters 

3. จะปรากฎหนา้ตา่ง Volume ขึน้บนหนา้จอ 

4. คลกิทเีมนูดรอปดาวน ์Color แลว้คลกิทีปุ่่ ม Color Rules 
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5. ดับเบิล้ยังชื่อของ Color Rules ที่ตอ้งการ แลว้คลิกปุ่ ม OK เช่น Today vs Prev เพื่อเปลี่ยนสีกราฟ 

Volume ตามเงือ่นไขนี ้

 

6. สขีอง Volume จะเปลีย่นไปตามเงือ่นไขทีก่ าหนดใน Color Rules 

 

 

 

 

 

 

 

 

 

 

 

 



Aspen for Windows User Guide v. 4.21 Build 0041913  May 2018 

 

ThaiQuest Limited    Helpdesk 02 651 4747 # 777    E-mail: helpdesk@thaiquest.com                                                            Page 24 of 72  

เสน้แนวโนม้ (Trend Lines) 

ทา่นสามารถเลอืกรปูแบบของเสน้แนวโนม้ (Trend Lines)ทีต่อ้งการ ไดโ้ดย 

 คลกิปุ่ มไอคอน  Trend Mode บนแถบเครือ่งมอื หรอื 

 คลกิเมา้สข์วา Ą Draw Trend Lines Ą คลกิเลอืกรปูแบบทีต่อ้งการจากเมนู 

 

แถบเครือ่งมอืของเสน้แนวโนม้  

หลังจากทีเ่ขา้สูโ่หมดของการวาดเสน้แนวโนม้ จะมแีถบเครือ่งมอืของเสน้แนวโนม้ ปรากฎขึน้บนหนา้จอ 

 

 โดยสามารถแบง่กลุม่ของเครือ่งมอืวาดเสน้แนวโนม้ ได ้2 กลุม่ ดังนี ้

 กลุม่ที ่1: รปูแบบเสน้แนวโนม้ 

 

ไอคอน รายละเอยีด 

 Trend Line เสน้แนวโนม้แบบอสิระ 

 Horizontal เสน้แนวโนม้แบบเสน้แนวนอน 

 Speed Lines เสน้แนวโนม้เสน้แนวโนม้ตามทฤษฎ ีSpeed Lines 

 Fibonacci เสน้แนวโนม้เสน้แนวโนม้ตามทฤษฎ ีFibonacci  

 

 

 Gann Time/Price เสน้แนวโนม้ตามทฤษฎ ีGann Time/Price 

 Gann Square เสน้แนวโนม้ตามทฤษฎ ีGann Square 

 Andrew’s Pitchfork เสน้แนวโนม้ตามทฤษฎ ีAndrew’s Pitchfork 
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 กลุม่ที ่2: เครือ่งมอืในการแกไ้ขเสน้แนวโนม้ 

 

ไอคอน รายละเอยีด 

 Move Line เคลือ่นยา้ยเสน้แนวโนม้ 

 Pivot Trend Line หมนุเสน้แนวโนม้ 

 Add Fibonacci Lines เพิม่เสน้แนวโนม้ Fibonacci จากเสน้แนวโนม้ทีเ่ลอืกไว ้

 Add Parallel Lines เพิม่เสน้แนวโนม้คูข่นานแบบอสิระจากเสน้แนวโนม้ทีเ่ลอืกไว ้ 

 Add Linked Parallel Line เพิม่เสน้แนวโนม้คู่ขนานจากเสน้แนวโนม้ทีเ่ลอืกไว ้ โดยจะลงิคก์ับ

เสน้แนวโนม้ทีเ่ลอืกไว ้

 Extend Line ยดืเสน้แนวโนม้ 

 Truncate Line หดเสน้แนวโนม้ 

 Delete Line ลบเสน้แนวโนม้ทีเ่ลอืกไว ้

 Delete Trend Line in a Group ลบเสน้แนวโนม้ทีอ่ยูใ่นกลุม่เดยีวกนั 

 Delete All Trend Lines ลบเสน้แนวโนม้ทัง้หมด 

 Labels On/Off แสดง/ซอ่นป้ายก ากบัของเสน้แนวโนม้ 

 Snap On/Off เปิด/ปิดการแนบเสน้แนวโนม้เขา้กบัแทง่กราฟทีใ่กลท้ีส่ดุ 

 Trend Line Status Window แสดงหนา้ตา่งแถบสถานะของเสน้แนวโนม้ 

 
 

 Fibonacci Options แสดงหนา้ตา่งตัวเลอืกของเสน้แนวโนม้ตามทฤษฎ ีFibonacci 

 Gann Options แสดงหนา้ตา่งตัวเลอืกของเสน้แนวโนม้ตามทฤษฎ ีGann 

การวาดเสน้แนวโนม้แบบอสิระ (Trend Line) 

1. เปิดกราฟทีต่อ้งการวาดเสน้แนวโนม้  

2. คลกิปุ่ มไอคอน  Trend Mode เพือ่เขา้สูโ่หมดของการวาดเสน้แนวโนม้ 

3. เคอรเ์ซอรเ์มา้สจ์ะเปลีย่นเป็นรปูดนิสอ  

4. คลกิปุ่ มไอคอน Trend Line 

5. คลกิเมา้สซ์า้ยทีจ่ดุเร ิม่ตน้ (จดุ A) แลว้ลากไปยงัจดุสิน้สดุ (จดุ B) แลว้ปลอ่ยเมา้ส ์

 

6. จะปรากฏเสน้แนวโนม้บนกราฟ  

7. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 
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การวาดเสน้แนวโนม้แบบแนวนอน (Horizontal) 

1. เปิดกราฟทีต่อ้งการวาดเสน้แนวโนม้  

2. คลกิปุ่ มไอคอน  Trend Mode เพือ่เขา้สูโ่หมดของการวาดเสน้แนวโนม้ 

3. เคอรเ์ซอรเ์มา้สจ์ะเปลีย่นเป็นรปูดนิสอ  

4. คลกิปุ่ มไอคอน  Horizontal  

5. คลกิเมา้สซ์า้ยยงัจดุทีต่อ้งการวาดเสน้แนวโนม้  

 

6. จะปรากฏเสน้แนวโนม้บนกราฟ 

7. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

 

การวาดเสน้แนวโนม้แบบคูข่นาน (Link Parallel) 

1. วาดเสน้แนวโนม้เสน้แรก 

 

2. คลกิปุ่ มไอคอน  Add Linked Parallel Line 

3. คลกิยงัต าแหน่งทีต่อ้งการเพิม่เสน้แนวโนม้คูข่นาน 

 

4. จะปรากฏเสน้แนวโนม้แบบคูข่นานบนกราฟ 

5. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 
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การวาดเสน้แนวโนม้ Andrews’ Pitchfork 

Andrews' Pitchfork เป็นเครือ่งมอืวเิคราะหท์ีน่ยิมอกีตัวหนึง่ในรูปแบบวธิ ีMedian Line (ML) ซึง่ถูกพัฒนา

โดย Dr Alan H. Andrews ซึง่วธิกีารนี้ม ี3 จุดราคาทีม่นัียส าคัญ คอื ก าหนดจุดเริม่ตน้จุดแรกของแนวโนม้ราคา

ก าหนดใหเ้ป็นจดุ A, จดุ B และสรา้งเสน้ Median Line เพือ่วาดกรอบการเคลือ่นทีข่องราคา  

แนวโนม้ขาขึน้ 

1. คลกิไอคอน Andrews’ Pitchfork 

2. ก าหนดจดุสงูสดุ (จดุ A), จดุต ่าสดุ (จดุ B) และจดุราคา (จดุ C) 

 

 

3. คลกิเมา้สซ์า้ยทีจ่ดุสงูสดุ (จดุ A)  

4. ลากเมา้สไ์ปทีจ่ดุต ่าสดุ (จดุ B) แลว้คลกิเมา้สซ์า้ยทีจ่ดุ B 

5. ลากเมา้สไ์ปทีจ่ดุราคา (จดุ C) จะปรากฏเสน้ Median Line แลว้คลกิเมา้สซ์า้ยทีจ่ดุ C 

 

6. จะปรากฏเสน้ Andrews’ Pitchfork บนกราฟ  
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ล าดบัตวัเลข Fibonacci 

Fibonacci (ฟิโบนาซี)่ เป็นล าดับตัวเลขอนุกรม ทีถู่กคน้พบโดย Leonardo Fibonacci 

นักคณิตศาสตร์ชาวอติาเลียน ซึง่เกดิจากการที่เขาไดส้ังเกต และศกึษาปรากฎการณ์ทาง

ธรรมชาตติ่างๆ เชน่ รูปแบบของฟ้าแลบ รูปแบบของผลไมต้่างๆ และรูปแบบของเปลอืกหอย

ทาก เป็นตน้ โดยพบว่าปรากฎการณ์เหล่านัน้มรีูปแบบปกต ิและค่อนขา้งสม ่าเสมอ โดยได ้

น ามาคดิเป็นตัวเลขทางคณติศาสตร ์คอื เกดิจากการน าตัวเลข 2 ตัวหนา้มาบวกกนั เชน่ 1 + 

1 = 2, 1 + 2 = 3, 2 + 3 = 5, 3 + 5 = 8 และตอ่ๆ ไป   

แต่ส ิง่ที่ท าใหต้อ้งพศิวงยิง่ไปกว่านั้นคือ ล าดับฟิโบนาซีต่ัง้แต่ตัวเลขค่าที่สี่เป็นตน้ไป มี

อัตราส่วนจากการหารตัวเลขล าดับหลังดว้ยตัวเลขล าดับหนา้ เชน่ 5 หารดว้ย 3, 8 หารดว้ย 5, 13 หารดว้ย 8, 

21 หารดว้ย 13 ไดผ้ลลัพธท์ีใ่กลเ้คยีงเลข 1.618 และเมือ่ตัวเลขเพิม่ขึน้ ผลลัพธท์ีไ่ดจ้ะยิง่ใกลเ้คยีง 1.618 เป็น

ล าดับ Leonardo จึงเรียกชื่อตัวเลข 1.618 นี้เป็นภาษากรีกโบราณว่า “ฟี” (Phi) หรือ“อัตราส่วนทองค า” 

(Golden ratio) ดังตารางดา้นลา่ง 

 

A B Fibonacci Series 
A + B 

Golden Ratio 
B / A 

0 1 1   

1 1 2 1 

1 2 3 2 

2 3 5 1.5 

3 5 8 1.666666667 

5 8 13 1.6 

8 13 21 1.625 

13 21 34 1.615384615 

21 34 55 1.619047619 

34 55 89 1.617647059 

55 89 144 1.618181818 

89 144 233 1.617977528 

144 233 377 1.618055556 

 

จากตัวเลข Fibonacci ดา้นบน จงึท าใหม้กีารประยกุตน์ ามาใชใ้นการวเิคราะหก์ารเคลือ่นไหวของราคาหุน้ ทีเ่ชือ่

ว่ามกีารเคลือ่นไหวในรูปแบบทีค่่อนขา้งแน่นอน เพือ่น าไปใชค้น้หาแนวโนม้แนวตา้น แนวรับ สัญญาณซือ้และ

ขายของราคาหุน้ เชน่ หากราคาตกลงมาเป็นสดัสว่นเทา่ไหรแ่ลว้ ก็จะมกีารเดง้กลับเทา่กลับสดัสว่นทีต่กลงมา  

 

การวาดเสน้แนวโนม้ Fibonacci Retracements 

Fibonacci Retracements คอื การหาจุดแนวรับและแนวตา้นเสน้ขนานแบบแนวนอน เพือ่หาราคาเป้าหมาย 

โดยใชต้ัวเลข Fibonacci number เป็นเป้าหมายในแตล่ะระดับ 
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แนวโนม้ขึน้ 

 

หากดจูากภาพดา้นบนจะเห็นวา่กราฟมลีักษณะเป็นแนวโนม้ขึน้ (ราคาขึน้ตอ่เนื่อง ยอ่ตัวลง แลว้เดง้ขึน้ตอ่) ท่าน

สามารถหาเป้าขาย โดยใชเ้ครือ่งมอื Fibonacci Retracements เพือ่ค านวณหาแนวรับ แนวตา้นไดโ้ดย 

1. คลกิปุ่ มไอคอน  Trend Mode เพือ่เขา้สูโ่หมดของการวาดเสน้แนวโนม้ 

2. เคอรเ์ซอรเ์มา้สจ์ะเปลีย่นเป็นรปูดนิสอ  

3. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Retracements จากเมนู 

4. หาจดุสงูสดุ และจดุต ่าสดุของชว่งราคา ดังภาพดา้นลา่ง 

 สรา้งจดุ A เป็นจดุสงูสดุ (จดุเริม่ตน้คา่ฟิโบนาซีจ่ะเทา่กบั 0%) 

 สรา้งจดุ B เป็นจดุต ่าสดุ (จดุต ่าสดุคา่ฟิโบนาซีจ่ะเทา่กบั 100%) 

 

5. คลกิเมา้สท์ีจ่ดุสงูสดุ (จดุ A) แลว้คลกิทีจ่ดุต า่สดุ (จดุ B) จะปรากฎเสน้แบง่ชอ่งวา่งระหวา่งจดุสงูสดุและ

จุดต ่าสุดตามระดับ Fibonacci Retracements (อัตราส่วนตัวเลขฟิโบนาซี)่ จากภาพดา้นล่างจะเห็นว่า

ราคามกีารเคลือ่นไหวอยูใ่นกรอบจดุ A ทีท่ าหนา้ทีเ่ป็นแนวตา้นและจดุ B ทีท่ าหนา้ทีเ่ป็นแนวรับ 

 

6. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 
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แนวโนม้ลง 

 

จากภาพกราฟดา้นบนจะเห็นว่า กราฟราคาเป็นแนวโนม้ลง (ราคาลงต่อเนื่อง เดง้ขึน้ แลว้ย่อตัวลงต่อ) ท่าน

สามารถหาเป้าซือ้โดยใชเ้ครือ่งมอื Fibonacci Retracements เพือ่ค านวณหาแนวรับ แนวตา้นไดโ้ดย 

1. คลกิปุ่ มไอคอน  Trend Mode เพือ่เขา้สูโ่หมดของการวาดเสน้แนวโนม้ 

2. เคอรเ์ซอรเ์มา้สจ์ะเปลีย่นเป็นรปูดนิสอ  

3. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Retracements จากเมนู 

4. หาจดุต ่าสดุ และจดุสงูสดุของชว่งราคา ดังภาพดา้นลา่ง 

 สรา้งจดุ A เป็นจดุต ่าสดุ (จดุเริม่ตน้คา่ฟิโบนาซีจ่ะเทา่กบั 0%) 

 สรา้งจดุ B เป็นจดุสงูสดุ (จดุสงูสดุคา่ฟิโบนาซีจ่ะเทา่กบั 100%) 

 

5. คลกิเมา้สท์ีจ่ดุต า่สดุ (จดุ A) แลว้คลกิทีจ่ดุสงูสดุ (จดุ B) จะปรากฎเสน้แบง่ชอ่งวา่งระหวา่งจดุต ่าสดุและ

จุดสงูสดุตามอัตราสว่นตัวเลขฟิโบนาซี ่จากภาพดา้นล่างจะเห็นวา่ราคามกีารเคลือ่นไหวอยูใ่นกรอบจุด A ที่

ท าหนา้ทีเ่ป็นแนวรับและจดุ B ทีท่ าหนา้ทีเ่ป็นแนวตา้น 

 

6. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 
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การวาดเสน้แนวโนม้ Fibonacci Arcs 

Fibonacci Arcs เป็นเสน้แนวโนม้แบบโคง้ครึง่วงกลมทีค่ านวณจากระยะทางของราคาสูงสุดและราคาต ่าสดุ 

โดยคดิระยะทางระหว่างจุดสงูสดุและจุดต ่าสดุเทา่กับ 100 แลว้ค านวณหาแนวรับ/แนวตา้นโดยใชล้ าดับตัวเลข 

Fibonacci ที ่38.2%, 50% และ 61.8% ตามล าดับ  

แนวโนม้ขาขึน้ 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Arcs จากเมนู 

2. หาจดุต า่สดุ (จดุ A) และจดุสงูสดุ (จดุ B)  

3. คลกิเมาสซ์า้ยทีจ่ดุต า่สดุ (จดุ A) แลว้ลากเมาสไ์ปยงัจดุสงูสดุ (จดุ B)  

 

 

4. และคลกิเมาสซ์า้ย จะปรากฎเสน้ Arc ขึน้ 

 

 

5. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

แนวโนม้ขาลง 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Arcs จากเมนู 

2. หาจดุสงูสดุ (จดุ A) และจดุต า่สดุ (จดุ B)  

3. คลกิเมาสซ์า้ยทีจ่ดุสงูสดุ (จดุ A) แลว้ลากเมาสไ์ปยงัจดุต า่สดุ (จดุ B)  
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4. และคลกิเมาสซ์า้ย จะปรากฎเสน้ Arc ขึน้ 

 

5. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

การวาดเสน้แนวโนม้ Fibonacci Fan 

แนวโนม้ขาขึน้ 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Fan จากเมนู 

2. หาจดุต า่สดุ (จดุ A) และ จดุสงูสดุ (จดุ B) 

3. คลกิเมาสซ์า้ยทีจ่ดุต า่สดุ (จดุ A) 

4. ลากเมาสไ์ปยงัจดุสงูสดุ (จดุ B) แลว้คลกิเมาสซ์า้ย 

 

5. จะปรากฎเสน้ Fan ขึน้ 

 

6. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

แนวโนม้ขาลง 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Fan จากเมนู 

2. หาจดุสงูสดุ (จดุ A) และ จดุต า่สดุ (จดุ B) 

3. คลกิเมาสซ์า้ยทีจ่ดุสงูสดุ (จดุ A)  

4. ลากเมาสไ์ปยงัจดุต า่สดุ (จดุ B) แลว้คลกิเมาสซ์า้ย 
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5. จะปรากฎเสน้ Fan ขึน้ 

 

6. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

การวาดเสน้แนวโนม้ Fibonacci Time Zone 

Fibonacci Time Zones คอื การสรา้งเสน้ฟิโบนาซีแ่บบแนวตัง้ โดยแบง่เป็นชว่งระยะเวลาตามล าดับตัวเลข 

Fibonacci (0, 1, 1, 2, 3, 5, 8, 13, 21…) เพือ่คาดการณ์แนวโนม้การเปลีย่นแปลงของราคาวา่จะไปในทศิทาง

ใด เมือ่ราคาวิง่เขา้ใกลห้รอืตรงกบัเสน้แบง่ชว่งเวลา 

แนวโนม้ขาขึน้ 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Single-Bar Time Zones จากเมนู 

2. คลกิเมาสซ์า้ยทีจ่ดุต า่สดุ  

 
3. จะปรากฎเสน้ Time Zone ขึน้ 

 

4. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

แนวโนม้ขาลง 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Single-Bar Time Zones จากเมนู 

2. คลกิเมาสซ์า้ยทีจ่ดุสงูสดุ  
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3. จะปรากฎเสน้ Time Zone ขึน้ 

 

4. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

การวาดเสน้แนวโนม้ Fibonacci Projections 

เป็นเครือ่งมอืทีช่ว่ยในการพยากรณ์แนวรับ-ตา้น เพือ่วเิคราะหร์าคาเป้าหมาย ซึง่ท่านตอ้งก าหนดจุด 3 จุด คอื 

จุดต ่าสุด, จุดสูงสุด และจุดกลับตัว (หรือที่จุดราคาปัจจุบัน) ทศิทางแนวโนม้ขาขึน้ใหก้ าหนดจุดต ่าสุดไปยัง

จดุสงูสดุและจดุราคาปัจจบุนั ในทางกลับกนัหากทา่นตอ้งการหาแนวโนม้ขาลงใหก้ าหนดจดุสงูสดุไปยงัจดุต า่สดุ

มาใหจ้ดุราคาปัจจบุนั  

แนวโนม้ขาขึน้ 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Projections จากเมนู 

2. หาจดุต า่สดุ (จดุ A), จดุสงูสดุ (จดุ B) และจดุกลบัตวั (จดุ C)  

3. คลกิเมาสซ์า้ยทีจ่ดุต า่สดุ (จดุ A)  

4. คลกิเมา้สซ์า้ยทีจ่ดุสงูสดุ (จดุ B) 

5. คลกิเมาสซ์า้ยทีจ่ดุกลบัตวั (จดุ C) 

 

6. จะปรากฎเสน้ Fibonacci Projection ขึน้ 

 

7. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

แนวโนม้ขาลง 

1. คลกิปุ่ มไอคอน Fibonacci แลว้คลกิ Projections จากเมนู 

2. หาจดุต า่สดุ (จดุ A), จดุสงูสดุ (จดุ B) และจดุกลบัตวั (จดุ C)  

3. คลกิเมาสซ์า้ยทีจ่ดุต า่สดุ (จดุ A)  

4. คลกิเมา้สซ์า้ยทีจ่ดุสงูสดุ (จดุ B) 
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5. คลกิเมาสซ์า้ยทีจ่ดุกลบัตวั (จดุ C) 

 

6. จะปรากฎเสน้ Fibonacci Projection ขึน้ 

 

7. คลกิปุ่ มไอคอน  Trend Mode เพือ่ออกจากโหมดของการวาดเสน้แนวโนม้ 

การต ัง้คา่ล าดบัตวัเลข Fibonacci  

ทา่นสามารถก าหนดล าดับตัวเลข Fibonacci ทีต่อ้งการ ไดจ้าก Fibonacci Options  

 คลกิปุ่ มไอคอน  Fibonacci Options บนแถบ

เครือ่งมอื หรอื 

 คลกิเมา้สข์วา Ą Options Ą Fibonacci  
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แถบเมน ู รายละเอยีด 

Fibonacci Lines ใชส้ าหรับเสน้แนวโนม้ Fibonacci Retracements 

Fibonacci Projections ใชส้ าหรับเสน้แนวโนม้ Fibonacci Projections 

 

 

รายการ รายละเอยีด 

Predefined เลอืกรปูแบบล าดับตัวเลขทีต่อ้งการ  

ตวัเลอืก รายละเอยีด 

Fibonacci Line 1 = 0.00% เป็นคา่ Default 

 Line 2 = 100.00% เป็นคา่ Default  

 Line 3 = 38.20% เป็นคา่ Default  

 Line 4 = 50.00% เป็นคา่ Default  

 Line 5 = 61.80% เป็นคา่ Default  

1/3 rds Line 1 = 0.00% เป็นคา่ Default  

 Line 2 = 100.00% เป็นคา่ Default  

 Line 3 = 33.33% เป็นคา่ Default  

 Line 4 = 66.66% เป็นคา่ Default  

Custom ก าหนดล าดับตัวเลขทีต่อ้งการ 

   
Line 1 ถกูก าหนดไวท้ี ่0.00% เป็นคา่ Default  ไมส่ามารถเปลีย่นได ้

Line 2 ถกูก าหนดไวท้ี ่100.00% เป็นคา่ Default  ไมส่ามารถเปลีย่นได ้

Line 3-8 ก าหนดคา่ % ทีต่อ้งการ 

 

ตวัเลอืก รายละเอยีด 

Mirror การเพิม่เสน้สะทอ้นเหนอืเสน้ 0% ส าหรับแนวโนม้ขาขึน้ หรอื 

ใตเ้สน้ 0% ส าหรับแนวโนม้ขาลง 

Repeat การเพิม่เสน้ Fibonacci Retracements ทีม่ากกวา่ 100%  

Extend Left ยดืเสน้แนวโนม้ไปทางซา้ย 

Extend Right ยดืเสน้แนวโนม้ไปทางขวา 

 

ปุ่ ม รายละเอยีด 

Save as Default ก าหนดใหเ้ป็นคา่ Default 

OK ตกลงการตัง้คา่ 

Cancel ยกเลกิการตัง้คา่ 

Apply ใชก้ารตัง้คา่ โดยยงัไมต่อ้งปิดหนา้ตา่งนี ้
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การยดืเสน้แนวโนม้ 

ดับเบิล้คลกิทีป่ลายเสน้แนวโนม้ดา้นทีต่อ้งการยดื 

 

การหดเสน้แนวโนม้ 

ดับเบิล้คลกิทีจ่ดุสว่นตอ่ขยายดา้นทีต่อ้งการหด 

 

การหมนุเสน้แนวโนม้ 

ท่านสามารถเปลีย่นจุดเริม่ตน้/จุดสิน้สดุในการวาดเสน้แนวโนม้ได ้โดยคลกิทีป่ลายเสน้แนวโนม้ดา้นทีต่อ้งการ 

เคอรเ์ซอรเ์มา้สจ์ะเปลีย่นจากรปูดนิสอ  เป็นรปูเป้ายงิ   แลว้ลากเมา้สไ์ปยงัจดุใหมท่ีต่อ้งการ 

 

การเปลีย่นสหีรอืพารามเิตอรข์องเสน้แนวโนม้ 

คลกิเมา้สข์วาทีเ่สน้แนวโนม้ทีต่อ้งการ แลว้เลอืก Parameters… จากเมนู จะปรากฎหนา้ต่าง Trend Line 

Parameters ขึน้มาบนหนา้จอ 
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การ Export ขอ้มลูจากกราฟไปยงั Microsoft Excel 

ท่านสามารถ Export ขอ้มูลจากกราฟไปยัง Microsoft Excel โดยอัพเดทขอ้มูลแบบไดนามกิ (Dynamic Data 

Exchange: DDE) โดยมวีธิกีาร ดังนี ้

1. เปิดหนา้กราฟทีต่อ้งการ Export ขอ้มลู 

2. คลกิเมา้สข์วาแลว้เลอืกค าสัง่ Copy All to DDE หรอื Copy to DDE 

ตวัเลอืก รายละเอยีด 

Copy All to DDE คัดลอก (Copy) ขอ้มลูในทกุๆ หนา้ตา่งยอ่ย 

Copy to DDE คัดลอก (Copy) ขอ้มลูเฉพาะหนา้ตา่งยอ่ยทีแ่อคทฟี 

 

3. เปิด Microsoft Excel 

4. คลกิปุ่ มไอคอน Paste DDE Link 
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*** สามารถอ่านวธิกีารตดิตัง้ Dynamic Data Exchange: DDE ไดท้ี่หนา้ (อ่านรายละเอยีดเพิม่เตมิหนา้ 

58) 

 

ฟงักช์นั SQ 

หนา้ตา่ง Single Quote ไวส้ าหรับดขูอ้มลูราคาโควทลา่สดุ  

 

 คลกิปุ่ มไอคอน   SQ บนแถบเครือ่งมอื เพือ่เรยีกดหูนา้ตา่ง W;SQ 

 พมิพ ์Symbol ทีต่อ้งการดขูอ้มลู แลว้กดปุ่ ม Enter 
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ฟงักช์นัโควท (Quote) 

ดขูอ้มลูราคาของ Symbol ทีต่อ้งการ  

 

 คลกิปุ่ มไอคอน   Quote บนแถบเครือ่งมอื แลว้เลอืกรปูแบบทีต่อ้งการจากเมนูดรอปดาวน์ 

 

เมน ู รายละเอยีด 

Free Format Quote โควทแบบฟรสีไตล ์

Quote Grid โควทแบบตารางแนวตัง้ 

Quote Board โควทแบบแนวนอน 

Ticker โควทแบบตัววิง่ 

โควทแบบตารางแนวต ัง้ (Quote Grid) 

1. คลกิปุ่ มไอคอน   Quote แลว้เลอืก Quote Grid จากเมนูดรอปดาวน ์

2. จะปรากฎหนา้ตา่ง Quote Grid ขึน้มาบนหนา้จอ 

3. คลกิเมา้สย์งับรรทัดทีต่อ้งการ พมิพ ์Symbol แลว้กดปุ่ ม Enter  

 

4. หลังจากกดปุ่ ม Enter แลว้ ชอ่งใส ่Symbol จะปรากฎในบรรทัดถัดไป  

5. พมิพ ์Symbol ทีต่อ้งการ แลว้กดปุ่ ม Enter 

 

6. กดปุ่ ม Esc เพือ่ปิด ชอ่งใส ่Symbol 

การเพิม่คอลมัน ์

1. คลกิเมา้สข์วาทีห่ัวขอ้คอลัมน ์แลว้เลอืก Add Column จากเมนู 

 

2. จะปรากฏหนา้ตา่ง Quote Codes ขึน้มา 
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เมน ู รายละเอยีด 

Depth of Market ยงัไมม่ใีหบ้รกิาร 

Formulas ฟิลดข์อ้มลูจากสตูรทีเ่ขยีนในรปูแบบ CHART( )  

Fundamental Data ฟิลดข์อ้มลูปัจจัยพืน้ฐาน 

Options ฟิลดข์อ้มลูทีเ่กีย่วขอ้งกบั Options 

Recently Used ฟิลดข์อ้มลูทีใ่ชล้า่สดุ 

Standard ฟิลดข์อ้มลูมาตรฐาน 

 

3. เลอืกหมวดของฟิลดข์อ้มลูทีต่อ้งการจากหนา้ตา่งดา้นซา้ยมอื โดยฟิลดข์อ้มลูในหนา้ตา่งดา้นขวามอื จะ
เปลีย่นตามหมวดทีเ่ลอืกดา้นซา้ย 

4. ดับเบิล้คลกิยงัฟิลดข์อ้มลูทีต่อ้งการในหนา้ตา่งดา้นขวามอื  

 

5. ฟิลดท์ีเ่ลอืกไวจ้ะถกูเพิม่ในวนิโดวโ์ควท 

 

การยา้ยคอลมัน ์

1. คลกิเมา้สใ์นคอลัมนท์ีต่อ้งการยา้ยคา้งไว ้
2. ลากเมา้สไ์ปยงัต าแหน่งทีต่อ้งการ แลว้ปลอ่ยเมา้ส ์
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การลบคอลมัน ์

1. คลกิเมา้สข์วาทีห่ัวขอ้คอลัมน ์แลว้เลอืก Delete Column จากเมนู 

2. คอลัมนท์ีเ่ลอืกไว ้จะถกูลบออกไป 

 

 

การเปลีย่นชือ่คอลมัน ์

1. คลกิเมา้สข์วาทีห่ัวขอ้คอลัมน ์แลว้เลอืก Edit Label… จากเมนู 

 

2. จะปรากฏชอ่ง ‘Label=“……….” ทีม่มุซา้ยมอืดา้นบนของวนิโดวโ์ควท  

 

3. พมิพช์ือ่คอลมันใ์หมท่ีต่อ้งการ หลังเครือ่งหมาย “ แลว้กดปุ่ ม Enter 

เชน่ เปลีย่นจาก “PCTCHG” เป็น “%CHG” 

 

 

การจดัเรยีงขอ้มลู 

คลกิเมา้สท์ีห่วัขอ้คอลัมน ์เพือ่เรยีงขอ้มลูจากนอ้ยไปมาก (Ascending) หรอืมากไปนอ้ย (Descending) โดยจะ

มไีอคอนรปุสามเหลีย่ม /อยูด่า้นหลังชือ่คอลัมน ์

 

การจดัเรยีงขอ้มลูโดยอตัโนมตั ิ

ทา่นสามารถจัดเรยีงขอ้มลูโดยอตัโนมตัเิมือ่ขอ้มลูเปลีย่น หรอืก าหนดชว่งเวลาได ้โดยมขีัน้ตอน ดังนี ้

1. คลกิยงัหัวขอ้คอลัมนท์ีต่อ้งการจัดเรยีง 
2. คลกิเมา้สข์วา แลว้เลอืก Properties… จากเมนู 
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3. จะปรากฎหนา้ตา่ง Quote Properties ขึน้มาบนหนา้จอ คลกิทีแ่ถบ Sorting 

 

 

ตวัเลอืก รายละเอยีด 

Double click sort ดับเบิล้คลกิทีห่ัวขอ้คอลัมนเ์พือ่จัดเรยีงขอ้มลู 

 

 

เมน ู รายละเอยีด 

Sort mode ทางเลอืกของการจัดเรยีง 

 Manual จัดเรยีงดว้ยตนเอง (Manual) 

 Timer จัดเรยีงอตัโนมตัแิบบตัง้เวลา ก าหนดเวลาทีต่อ้งการจาก Sort timer 

 Update จัดเรยีงอตัโมตัเิมือ่ขอ้มลูอพัเดท 

4. เลอืกรปูแบบการจัดเรยีงทีต่อ้งการจาก Sort mode แลว้ก าหนดขอ้มลูตามตอ้งการ (ถา้ม)ี 

5. คลกิปุ่ ม OK 

 

การเพิม่บรรทดั 

1. เลือ่นเคอรเ์ซอรเ์มา้สไ์ปยงัจดุทีต่อ้งการจะเพิม่บรรทดั 

2. คลกิเมา้สข์วา แลว้เลอืก Insert Blank จากเมนู 

3. จะมบีรรทัดวา่งเพิม่ขึน้มา 
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การลบบรรทดั 

1. เลือ่นเคอรเ์ซอรเ์มา้สไ์ปยงับรรทัดทีต่อ้งการจะลบ 

2. คลกิเมา้สข์วา แลว้เลอืก Delete Instrument จากเมนู 

3. บรรทัดทีเ่ลอืกไว ้จะหายไป 
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ฟงักช์นัขา่ว (News)  

ขา่วเรยีลไทม ์ดา้นการลงทุนทัง้ภาษาไทยและภาษาอังกฤษ จากแหล่งขา่วชัน้น าทัง้ในและตา่งประเทศ รวมถงึ

บทวเิคราะหจ์ากโบรกเกอร ์โดยใหบ้รกิารขา่วยอ้นหลัง 180 วัน 

 

 คลกิปุ่ มไอคอน   News บนแถบเครือ่งมอื เพือ่เปิดวนิโดวข์า่วภาษาไทยและภาษาองักฤษ 

 คลกิปุ่ มไอคอน   TNews บนแถบเครือ่งมอื เพือ่เปิดวนิโดวข์า่วภาษาไทย 

แถบเครือ่งมอืของฟงักช์นัขา่ว 

 

ไอคอน รายละเอยีด 

 Up 1 line เลือ่นเคอรเ์ซอรข์า่วขึน้ไป 1 บรรทัด 

 Down 1 line เลือ่นเคอรเ์ซอรข์า่วลงมา 1 บรรทัด 

 Page Up เลือ่นหนา้ขา่วขึน้ไป 1 หนา้ (1 หนา้จะม ี50 หัวขอ้ขา่ว) 

 Page Down เลือ่นหนา้ขา่วลงมา 1 หนา้ (1 หนา้จะม ี50 หัวขอ้ขา่ว) 

 Back to Top ไปยงัขา่วชนิลา่สดุ 

 Show All Headlines แสดงขา่วทัง้หมด 

 Sources เลอืกแหลง่ขา่ว 

 Categories เลอืกหมวดขา่ว 

 Date คน้หาขา่วโดยระบชุว่งเวลา 

 Search Headlines คน้หาขา่วตามค าคน้ 

 Properties ก าหนดคา่ตา่งๆ  

 Print Story พมิพเ์นือ้ขา่ว 

 Copy Story to Clipboard คัดลอกเนือ้ขา่ว 

 Email News Story แชรข์า่วทางอเีมล ์

 Download File ดาวนโ์หลดไฟลแ์นบ 

 Disable Dynamic Update หยดุการอพัเดทขา่วเป็นการชัว่คราว 

การอา่นขา่ว 

 คลกิยงัหัวขอ้ขา่วทีต่อ้งการ เพือ่แสดงเนือ้ขา่ว  

 คลกิเมา้สใ์นหนา้เนือ้ขา่ว เพือ่กลับมายงัหนา้ทีแ่สดงหัวขอ้ขา่ว 

 กรณีทีเ่นือ้ขา่วมยีาวเกนิหนา้จอจะมแีถบเลือ่น (Scrollbar) ใหท้า่นเลือ่นแถบเลือ่น หรอืหมนุลอ้หมนุบนเมา้ส์

เพือ่อา่นเนือ้ขา่วดา้นลา่ง  
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การคน้หาขา่วตามแหลง่ขา่ว 

คลกิปุ่ มไอคอน  Sources แลว้เลอืกแหล่งขา่วทีต่อ้งการจากเมนู แกรู้ป**ตัด Dow Jones News ออกแลว้ 

>> Pic: 004-A4W-News Sources หนา้ 45  

  

เมน ู ภาษา แหลง่ขา่ว ชือ่ยอ่ 

All Sources   ทกุแหลง่ขา่ว - 

Aspen Alert   Breaking News จากแอสเพน ALRT 

Aspen Annoucement   ประกาศจากแอสเพน ANNA 

Cabinet Resolutions  มตคิณะรัฐมนตร ี CABT 

Cabinet Resolutions Synopsis  มตคิณะรัฐมนตร ี CABE 

Commentaries and Research Articles   บทวเิคราะหจ์ากโบรกเกอร ์ CMNT 

Hoon Inside News   ส านักขา่วหุน้อนิไซต ์(บรกิารเสรมิ) HOI 

InfoQuest   ส านักขา่วอนิโฟเควสท ์ IQ 

International Press Release   ขา่วประชาสมัพันธจ์ากทัว่โลก PRI, ANPI 

Kyodo News   ส านักขา่วเกยีวโด KDN 

Listed Company News   ขา่วบรษัิทจดทะเบยีนจาก ตลท. SIMS 

Local Press Release   ขา่วประชาสมัพันธภ์ายในประเทศ PRG 

Money Channel   ส านักขา่วมนันี ่แชนแนล MC 

Newspaper Summaries  สรปุขา่วหนังสอืพมิพใ์นประเทศ PSUM 

Xin Hua News   ส านักขา่วซนิหัว XNA 

การคน้หาขา่วตามหมวดขา่ว  

คลกิปุ่ มไอคอน  Categories แลว้เลอืกหมวดขา่วทีต่อ้งการจากเมนู 
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การคน้หาขา่วโดยก าหนดชว่งเวลา 

1. คลกิปุ่ มไอคอน  Date จะปรากฎหนา้ตา่ง Date Range Search ขึน้มาบนหนา้จอ 

 

เมน ู รายละเอยีด 

Today แสดงเฉพาะขา่วของวันนีเ้ทา่นัน้ 

Last แสดงขา่วลา่สดุในรอบเวลาทีก่ าหนด  

 พมิพต์ัวเลขทีต่อ้งการในชอ่ง   หรอื คลกิปุ่ มไอคอน  

 เลอืกเวลาทีต่อ้งการจากเมนูดรอปดาวน ์

 

Date Between ก าหนดชว่งเวลาโดยระบวุันที/่เวลาเริม่ตน้ (From) และวันที/่เวลาสิน้สดุ (To) 

 พมิพว์ันทีท่ีต่อ้งการในชอ่ง  โดยพมิพใ์นรปูแบบ MM/DD/YY  

 เลอืกเวลาทีต่อ้งการจากเมนูดรอปดาวน์  

 

All Available News แสดงขา่วทัง้หมด 

 

ตวัเลอืก รายละเอยีด 

Oldest first เรยีงขา่วตามวันทีจ่ากเกา่ไปใหม ่ 

 

ปุ่ ม รายละเอยีด 

Reset รเีซทกลบัเป็นคา่เริม่ตน้ (Defaut) 

OK ตกลงการตัง้คา่ 

Cancel ยกเลกิการตัง้คา่ 

Apply ใชก้ารตัง้คา่ โดยยงัไมต่อ้งปิดหนา้ตา่งนี ้
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การคน้หาขา่วตามค าคน้ 

การคน้หาขา่วตามค าคน้ท าได ้2 วธิ ีดังนี ้

 พมิพเ์ครือ่งหมาย “/” แลว้ตามดว้ยค าคน้ทีต่อ้งการ เชน่ /เฟด หรอื 

 คลกิปุ่ มไอคอน  Search Headlines แลว้พมิพค์ าคน้ทีต่อ้งการในชอ่ง “Search For:” 

 

 คน้หาขา่วทีม่คี าคน้มากกวา่ 1 ค า โดยใชค้ าเชือ่มได ้ดังนี ้

ค าเชือ่ม รายละเอยีด 

เวน้วรรค 

และ  

AND 

คน้หาขา่วทีม่ทีกุๆ ค าในขา่วชิน้นัน้ เชน่ ตอ้งการคน้หาขา่วทีม่คี าวา่ “เฟด” และ 

“QE” ในขา่วชิน้เดยีวกนั ใหพ้มิพค์ าคน้ ได ้3 แบบ ดังนี ้

 เฟด QE  

 เฟด และ QE  

 เฟด AND QE 

, (คอมมา่) 

หรอื  

OR 

 

คน้หาขา่วทีม่บีางค าในขา่วชิน้นัน้ เชน่ ตอ้งการคน้หาขา่วทีม่คี าวา่ “เฟด” หรอื 

“QE” ในขา่วชิน้เดยีวกนั ใหพ้มิพค์ าคน้ ได ้3 แบบ ดังนี ้

 เฟด,QE  

 เฟด หรอื QE  

 เฟด OR QE 

 คน้หาขา่วทีม่ชี ือ่บคุคล หรอื กลุม่ค า ใหพ้มิพเ์ครือ่งหมายอญัประกาศ (" ") ครอ่มระหวา่งค าคน้ เชน่  

“บารัค โอบามา” “เจเน็ต เยลเลน” “มารโิอ ดราก”ิ 

การคน้หาขา่วตาม Symbol 

คน้หาขา่วทีเ่กีย่วขอ้งกบั Symbol ทีต่อ้งการได ้โดยพมิพเ์ครือ่งหมาย “%” น าหนา้ Symbol ทีต่อ้งการ เชน่  

%BBL คน้หาขา่วทีเ่กีย่วกบัหุน้ BBL 

 

การคดัลอกเนือ้ขา่ว 

ทา่นสามารถคดัลอกเนือ้ขา่วทีต่อ้งการ ไปวางไวย้งัแอพพลเิคชนัอืน่ได ้โดยมวีธิกีาร ดังนี ้

1. คลกิเมา้สย์งัหวัขอ้ขา่วทีต่อ้งการคดัลอกเนือ้ขา่ว 

2. คลกิปุ่ มไอคอน  Copy Story to Clipboard หรอืคลกิเมา้สข์วา แลว้เลอืก Story to Clipboard 

3. เปิดแอพพลเิคชนัทีต่อ้งการ แลว้เลอืกค าสัง่ Paste 
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การดาวนโ์หลดไฟลแ์นบ 

บางชิน้ขา่วจะมไีฟลแ์นบชนดิ PDF หรอื Zip มาดว้ย ทา่นสามารถดาวนโ์หลดไฟลแ์นบได ้โดยมวีธิกีาร ดังนี ้ 

1. เปิดชิน้ขา่วทีม่ไีฟลแ์นบ เพือ่เขา้สูห่นา้ทีแ่สดงเนือ้ขา่ว 

2. คลกิปุ่ มไอคอน  Download File หรอืคลกิเมา้สข์วา แลว้เลอืก Download File 

 

 กรณีทีเ่ป็นไฟล ์PDF 

 

 กรณีทีเ่ป็นไฟล ์Zip 
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ฟงักช์นัฟิกซฟ์อรแ์มต (Fixed Format)  

แสดงขอ้มลูตา่งๆ ในรปูแบบของ Text Page ซึง่จัดกลุม่ขอ้มลูเป็นหมวดหมู ่ 

 

 คลกิปุ่ มไอคอน   Fixed Format บนแถบเครือ่งมอื เพือ่เรยีกดหูนา้ฟิกซฟ์อรแ์มต 

แถบเครือ่งมอืของฟงักช์นัฟิกซฟ์อรแ์มต 

 

ไอคอน ปุ่ มคยีล์ดั รายละเอยีด 

 Page Up Page Up เปิดหนา้กอ่นหนา้นี้ 

 Page Down Page Down เปิดหนา้ถัดไป 

 - Properties ก าหนดคา่ตา่งๆ 

การเรยีกดขูอ้มลู 

 พมิพห์มายเลขหนา้ทีต่อ้งการ แลว้กดปุ่ ม Enter 

 ขอ้มลูแบง่เป็น 2 หมวดใหญ่ๆ  ดังนี ้

กลุม่ขอ้มลู หมายเลขหนา้ 

ขอ้มลูภายในประเทศ  

» สารบญั 10000 

» คน้หา Symbol  10200 

ขอ้มลูตา่งประเทศ  

» สารบญั 1 

» คน้หา Symbol  900 
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ฟงักช์นั Extension 

Extension เป็นฟังกช์นัเพิม่เตมิบนบรกิาร Aspen for Windows ซึง่แสดงขอ้มลูพืน้ฐานและรายละเอยีดของ

หลกัทรัพย ์พรอ้มทัง้ขอ้มลู Analyst Consensus จากสมาคมนักวเิคราะหห์ลกัทรัพย ์

 

 คลกิปุ่ มไอคอน  Extension บนแถบเครือ่งมอื 

ไอคอน รายละเอยีด 

 Help เปิดหนา้จอชว่ยเหลอื 

 Export Data to Excel สง่ขอ้มลูออกไปยงั Microsoft Excel 

 Print พมิพข์อ้มลูออกทางเครือ่งพมิพ ์

 Language เปลีย่นการแสดงผลเป็นภาษาไทย 

 Language เปลีย่นการแสดงผลเป็นภาษาองักฤษ 

 ฟังกช์นันีป้ระกอบดว้ยเมนูหลักและเมนูยอ่ย เมือ่คลกิทีเ่มนูหลกั จะปรากฎเมนูยอ่ยขึน้มาบนหนา้จอ 

เมน ู รายละเอยีด 

COMPANY ขอ้มลูบรษิทั 

»      Company Profile ประวัตบิรษัิท 

»      Company Highlight ขอ้มลู Highlight ของบรษัิท 

»      Capital & Par Changes การเปลีย่นแปลงทนุจดทะเบยีนและราคาพารย์อ้นหลัง 

»      Rights & Benefits สทิธปิระโยชนผ์ูถ้อืหุน้ เชน่ XD, XR, XE 

»      Investment การลงทนุ 

»      Directors กรรมการบรษัิท 

»      Major Shareholders ผูถ้อืหุน้รายใหญ ่

CONSENSUS ขอ้มลูประมาณการ 

»      Analyst Opinion ขอ้มลูประมาณการ 

»      Detailed Estimates ความเห็นนักวเิคราะห ์

FINANCIAL ขอ้มลูงบการเงนิ 

»       Financial Highlight ขอ้มลูทางการเงนิส าคญั 

TRADING DATA ขอ้มลูการซือ้ขาย 

»      Stock Comparison ขอ้มลูเปรยีบเทยีบรายหลักทรัพย ์ 
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»      NVDR Trading ขอ้มลูการซือ้ขาย NVDR – รายวัน / สะสม / ยอ้นหลัง 

»      Short Sales  ขอ้มลูธรุกรรมขายชอรต์ – รายวัน / สะสม / ยอ้นหลัง 

»      Insider Transactions ขอ้มลูการซือ้/ขายหุน้ของผูบ้รหิาร – รายวัน / ยอ้นหลัง  

 

การสรา้งหนา้เพจสว่นตวั 
1. คลกิปุ่ มไอคอน  Clear Screen บนแถบเครือ่งมอื เพือ่เปิดหนา้วา่ง 

2. คลกิปุ่ ม  Open Window แลว้ ดับเบิล้ยงัชือ่วนิโดวท์ีต่อ้งการในหนา้ตา่ง Window Manager หรอื 

คลกิเลอืกประเภทของวนิโดวท์ีต่อ้งการจากไอคอนบนแถบเครือ่งมอื  

 

3. จัดหนา้จอตามตอ้งการ  

การจดัการหนา้จอ รายละเอยีด 

ยา้ยวนิโดว ์ คลกิเมา้สย์งัแถบชือ่เรือ่ง (Title Bar) แลว้ลากไปยงัต าแหน่งทีต่อ้งการ 

ปรับขนาดวนิโดว ์  เลือ่นเมา้สไ์ปยงัดา้นทีต่อ้งการปรับขนาด  

 เคอรเ์ซอรเ์มา้ส ์  จะเปลีย่นเป็นรปู  

 คลกิเมา้สซ์า้ยคา้งไว ้แลว้ลากเมา้สเ์พือ่ปรับขนาดตามตอ้งการ 

 เมือ่ไดข้นาดทีต่อ้งการแลว้ ปลอ่ยเมา้ส ์

4. คลกิปุ่ มไอคอน  Save จะปรากฎหนา้ตา่ง Save ขึน้มาบนหนา้จอ  

5. คลกิเลอืกโฟลเดอรท์ีต่อ้งการบนัทกึหนา้เพจนี ้ 
หากตอ้งการสรา้งโฟลเดอรใ์หม ่คลกิปุ่ ม New Folder… พมิพช์ือ่โฟลเดอรท์ีต่อ้งการ แลว้กดปุ่ ม Enter 

 

6. พมิพช์ือ่หนา้เพจทีต่อ้งการในชอ่ง “Name:” แลว้คลกิปุ่ ม OK 
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ตวัอยา่ง: ตอ้งการสรา้งหนา้จอทีป่ระกอบไปดว้ย Chart, Quote Grid และ News มวีธิกีาร ดังนี ้

1. คลกิปุ่ มไอคอน  Chart เพือ่เพิม่วนิโดว ์Chart ขึน้มาบนหนา้จอ 

 

2. คลกิปุ่ มไอคอน  Quote แลว้เลอืก Quote Grid ในเมนูดรอปดาวน ์เพือ่เพิม่วนิโดว ์Quote Grid 

ขึน้มาบนหนา้จอ 

 

3. คลกิปุ่ มไอคอน  News เพือ่เพิม่วนิโดว ์News ขึน้มาบนหนา้จอ 
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4. จัดต าแหน่ง/ปรับขนาดของวนิโดวต์ามตอ้งการ  

5. คลกิเมา้สซ์า้ยเพือ่เลอืกวนิโดวท์ีต่อ้งการ (ท าใหเ้ป็นแอคทฟีวนิโดว)์ แลว้พมิพ ์Symbol ทีต่อ้งการ (Chart, 

Quote Grid) หรอืค าคน้ทีต่อ้งการ (News) 

 

7. คลกิปุ่ มไอคอน  Save จะปรากฎหนา้ตา่ง Save ขึน้มาบนหนา้จอ  

8. เลอืกโฟลเดอรท์ีต่อ้งการ พมิพช์ือ่หนา้ในชอ่ง Name: แลว้คลกิปุ่ ม OK 
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9. จะปรากฎชือ่หนา้เพจทีต่ัง้ไว ้อยูท่ีแ่ถบชือ่เรือ่ง (Title Bar) 

 

การเรยีกดหูนา้เพจ (ปุ่ ม F3) 

ทา่นสามารถเรยีกดหูนา้เพจส าเร็จรปูทีท่างแอสเพนเตรยีมไวใ้ห ้หรอืหนา้เพจทีท่า่นสรา้งเอง ไดโ้ดย 

1. คลกิปุ่ มไอคอน  Open Page บนแถบเครือ่งมอื หรอื กดปุ่ ม F3 บนคยีบ์อรด์  

2. จะปรากฏหนา้ตา่ง Page Manager ขึน้มาบนหนา้จอ 

 

3. เลอืกโฟลเดอรท์ีต่อ้งการ  
4. ดับเบิล้คลกิยงัชือ่หนา้เพจ เพือ่เปิดหนา้เพจนัน้ๆ  

การก าหนดปุ่ มคยีล์ดั (Shortcut Key) 

ท่านสามารถก าหนดปุ่ มคยีล์ัด (Shortcut Key) ในการเปิดหนา้เพจ/หนา้วนิโดว/์ค าสั่งต่างๆ ได ้เพือ่เพิม่ความ

สะดวกรวดเร็วในการใช ้โดยมขีัน้ตอน ดังนี ้

1. คลกิที ่Tools > Shortcut Keys… หรอื พมิพค์ าสัง่ .KEYS แลว้กดปุ่ ม Enter  

2. จะปรากฎหนา้ตา่ง Main Shortcut Keys ขึน้มาบนหนา้จอ  
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3. กดปุ่ มคยีล์ัดทีต่อ้งการ หรอื คลกิทีช่อ่ง Value ขา้งปุ่ มคยีล์ัดทีต่อ้งการ จะปรากฎหนา้ตา่งสีเ่หลีย่มขึน้มา  

 

4. พมิพช์ือ่หนา้เพจ/หนา้วนิโดว/์ค าสัง่ทีต่อ้งการเขา้ไป แลว้กดปุ่ ม Enter 

5. คลกิปุ่ มกากบาททีม่มุขวาบนเพือ่ปิดหนา้จอนี้ 
 

ระบบเตอืน (Alarms) 

ทา่นสามารถตัง้เตอืนเมือ่ Symbol ทีส่นใจถงึระดบัราคาทีต่อ้งการได ้ 

การเพิม่เง ือ่นไขต ัง้เตอืน 

1. คลกิทีแ่ถบเมนู เลอืก Tools แลว้เลอืก Alarms 

2. จะปรากฎหนา้ตา่ง Alarm List ขึน้มาบนหนา้จอ  

 
3. คลกิปุ่ ม Add จะปรากฎหนา้ตา่ง New Alarm ขึน้มาบนหนา้จอ 

 



Aspen for Windows User Guide v. 4.21 Build 0041913  May 2018 

 

ThaiQuest Limited    Helpdesk 02 651 4747 # 777    E-mail: helpdesk@thaiquest.com                                                            Page 57 of 72  

เมน ู รายละเอยีด 

Trigger condition  พมิพเ์งือ่นไขทีต่อ้งการเตอืน ในรปูแบบ 

<Symbol><Expression><Price Level>  

เชน่ PTT<390 

ตวัด าเนนิการ รายละเอยีด ตวัอยา่ง 
== เทา่กบั KBANK==220 

>= มากกวา่หรอืเทา่กบั IQXGL>=1200 

> มากกวา่ SET>1600 

<= นอ้ยกวา่หรอืเทา่กบั IQXWTI<=65 

< นอ้ยกวา่ IQXUSTB<32 

    
 

เมน ู รายละเอยีด 

Memorandum and 

email subject 

 ขอ้ความทีต่อ้งการใหแ้สดง เมือ่ระบบเตอืนตามเงือ่นไขทีก่ าหนด 

Command actions  

on trigger 

 พมิพค์ าสัง่หรอืชือ่หนา้เพจทีต่อ้งการ 

 ใสเ่ครือ่ง “;” คั่นระหวา่งค าสัง่ เชน่  

» F7-CHART;PTT เปิดหนา้ F7-CHART แลว้เปลีย่น Symbol เป็น PTT 

» F8-NEWS;/PTT เปิดหนา้ F8-NEWS แลว้คน้หาค าวา่ PTT 

Trigger state  สถานะของเงือ่นไขทีต่อ้งการใหเ้ตอืน 

» True เตอืนเมือ่เงือ่นไขเป็นจรงิ 

» False เตอืนเมือ่เงือ่นไขเป็นเท็จ 

» Changes เตอืนเมือ่เงือ่นไขเปลีย่นแปลง 
Trigger frequency  ความถีใ่นการเตอืน 

» Continuous เตอืนทกุครัง้ 

» Daily เตอืนวันละครัง้ 

» Once เตอืนครัง้เดยีว 

Enable  เปิด/ปิดการเตอืน 

Auto-Delete  ลบเงือ่นไขทันทหีลังจากแจง้เตอืนแลว้ 

Visual alert  แสดง/ซอ่นหนา้ตา่ง Pop-up เมือ่เตอืน 

Audio alarm  เลอืกเสยีงทีต่อ้งการใหร้อ้งเตอืน 

Audio repeat  เปิด/ปิดการรอ้งเตอืนซ ้า 

E-mail  ยงัไมเ่ปิดใหบ้รกิาร 

Current state  แสดงสถานะของเงือ่นไขทีก่ าหนด 

4. คลกิปุ่ ม OK 

การลบเงือ่นไขต ัง้เตอืน 

1. คลกิทีแ่ถบเมนู เลอืก Tools แลว้เลอืก Alarms 

2. จะปรากฎหนา้ตา่ง Alarm List ขึน้มาบนหนา้จอ  

3. คลกิยงัเงือ่นไขทีต่อ้งการลบจะมแีถบสฟ้ีาขึน้มา 
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4. คลกิปุ่ ม Delete 

 

การ Export ขอ้มลูโดยใช ้DDE   

Aspen Graphics DDE Link คอือะไร 

Aspen Graphics DDE Link เป็นโปรแกรมเสรมิเพือ่ใชส้ าหรับดงึขอ้มลูจาก Aspen for Windows ไปยงั 

Microsoft Microsoft Excel และมกีารอพัเดทขอ้มลูแบบไดนามกิ โดยสามารถดงึขอ้มลูได ้3 รปูแบบ ดังนี ้

1. Quote ใชส้ าหรับดงึขอ้มลูของวันปัจจบุนั 

2. History ใชส้ าหรับดงึขอ้มลูยอ้นหลัง 

3. Formula ใชส้ าหรับดงึขอ้มลูจากสตูรทีส่รา้งเอาไว ้

ซึง่การดงึขอ้มลูผา่น Aspen Graphics DDE Link จะตอ้งเปิดโปรแกรม Aspen for Windows กอ่นทกุครัง้  

ไฟลท์ีใ่ชส้ าหรบัตดิต ัง้ Aspen Graphics DDE บน Excel 

 

ไฟลต์ดิตัง้ Aspen Graphics DDE Link จะเก็บไวใ้น C:\Aspen\MSExlDDE ซึง่ประกอบไปดว้ยไฟลต์า่งๆ 

ดังนี ้

1. โฟลเดอร ์IconDDE  

2. agdde32.dll (Date modified: 28 Aug 2014) 

3. ARG32.XLA (Date modified: 05 Nov 2014) เป็น Add-Ins ส าหรับ Microsoft Excel 2003 

4. Arg32.xlam (Date modified: 18 Feb 2013) เป็น Add-Ins ส าหรับ Microsoft Excel 2007 ขึน้ไป 

5. QMASTER.XLB (Date modified: 18 Feb 2013) ใชส้ าหรับเรยีกแถบเครือ่งมอื Aspen Graphics DDE 

บน Microsoft Excel 2003 
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วธิตีดิต ัง้ Aspen Graphics DDE บน Microsoft Excel 2003 

1. Copy ไฟล ์agdde32.dll ไวใ้น C:\Windows\System32 

2. เปิดโปรแกรม Microsoft Excel 

3. คลกิที ่Tools > Add-Ins 

4. จะปรากฏหนา้ตา่ง Add-Ins ขึน้มา 

 

5. คลกิปุ่ ม Browse แลว้เลอืกไดเร็กทอรทีีต่ดิตัง้โปรแกรม Aspen Graphics โดยปกตจิะเป็น 

C:\Aspen\MSExlDDE 

 

6. ดับเบิล้คลกิทีไ่ฟล ์ARG32 หรอื ARG32.XLA  

7. จะปรากฎหนา้ตา่ง Add-Ins และมเีครือ่งหมาย a หนา้ค าวา่ “Aspen Graphics DDE Add-in”   

 

8. คลกิปุ่ ม OK เพือ่ปิดหนา้ตา่ง Add-Ins 

9. คลกิที ่File > Open แลว้เลอืกไฟล ์QMASTER.XLB จากไดเร็กทอร ีC:\Aspen\MsExlDDE  

 

 

 

 

 

 



Aspen for Windows User Guide v. 4.21 Build 0041913  May 2018 

 

ThaiQuest Limited    Helpdesk 02 651 4747 # 777    E-mail: helpdesk@thaiquest.com                                                            Page 60 of 72  

10. จะมแีถบเครือ่งมอืของ Aspen Graphics DDE ขึน้มา ดังภาพ 

 

11. ปิดและเปิด Microsoft Excel ใหมอ่กีครัง้ เพือ่ใหก้ารตดิตัง้เสร็จสมบรูณ์ 

วธิตีดิต ัง้ Aspen Graphics DDE บน Microsoft Excel 2007 ขึน้ไป 

1. Copy ไฟล ์agdde32.dll ไวใ้น C:\Windows\System32  

ส าหรับ Microsoft Office 64-bit ให ้Copy ไฟลไ์วใ้น C:\Windows\SysWOW64 

2. เปิดโปรแกรม Microsoft Excel 

3. คลกิที ่File > Options จะปรากฏหนา้ตา่ง Excel Options ขึน้มา 

4. คลกิที ่Add-Ins ในหนา้ตา่งดา้นซา้ย คลกิทีปุ่่ ม Go ตรงดา้นลา่งของหนา้ตา่งนี ้ 

 

5. จะปรากฏหนา้ตา่ง Add-Ins ขึน้มา คลกิปุ่ ม Browse  

 

6. เลอืกไดเร็กทอรทีีต่ดิตัง้โปรแกรม Aspen Graphics โดยปกตจิะเป็น C:\Aspen\MSExlDDE 
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7. ดับเบิล้คลกิทีไ่ฟล ์Arg32 หรอื Arg32.xlam  

 

8. จะปรากฎหนา้ตา่ง Add-Ins และมเีครือ่งหมายa หนา้ค าวา่ “Arg32”   

 

9. คลกิปุ่ ม OK เพือ่ปิดหนา้ตา่ง Add-Ins 

10. ปิดและเปิด Microsoft Excel ใหมอ่กีครัง้ เพือ่ใหก้ารตดิตัง้เสร็จสมบรูณ์ 

แถบเครือ่งมอื Aspen Graphics DDE Link 

เมือ่ตดิตัง้ Aspen Graphics DDE เรยีบรอ้ยแลว้ จะมแีถบ Aspen Graphics และม ีAspen Graphics 

DDE Quick Link อยูใ่นเมนู เมือ่คลกิปุ่ มขวาของเมา้ส ์ดังภาพ 

แถบเครือ่งมอืบน Microsoft Excel 2003 

 

แถบเครือ่งมอืบน Microsoft Excel 2007 ข ึน้ไป 

 



Aspen for Windows User Guide v. 4.21 Build 0041913  May 2018 

 

ThaiQuest Limited    Helpdesk 02 651 4747 # 777    E-mail: helpdesk@thaiquest.com                                                            Page 62 of 72  

การดงึขอ้มลูโควท (Quote)  

การดงึขอ้มลูโควท (Quote) ออกไปยงั Microsoft Excel สามารถท าได ้2 วธิ ีคอื 

1. เมนู Create DDE Link  

2. เมนู Aspen Graphics DDE Quick Link 

 

โดยวธิกีารใชง้านแตล่ะวธิมีรีายละเอยีด ดังนี ้

เมน ูCreate DDE Link 

ดงึขอ้มลู Quote ไดค้ราวละ 1 Symbol เทา่นัน้ และหากตอ้งการเปลีย่น Symbol หรอื Field จะตอ้งเขา้ไป

เปลีย่นจากแถบ Formula ใน Microsoft Excel แลว้กดปุ่ ม Ctrl+Shift+Enter พรอ้มกนั หรอืเลอืก 

Create DDE Link ใหมอ่กีครัง้ 

1. คลกิไอคอน Create DDE Link บนแถบเครือ่งมอื 

2. จะปรากฎหนา้ตา่ง DDE Link Generator Helper Dialog ขึน้มาบนหนา้จอ 

 

เมน ู รายละเอยีด 

Symbol Symbol ของขอ้มลูทีต่อ้งการดงึขอ้มลู 

Short List  แสดง Field ขอ้มลูทีส่ าคญั คลกิเพือ่เลอืกรปูแบบทีต่อ้งการ 

Long List แสดง Field ขอ้มลูทัง้หมด คลกิเพือ่เลอืกรปูแบบทีต่อ้งการ 

 

ปุ่ ม รายละเอยีด 

 

สง่ Field ทีเ่ลอืกไวไ้ปยงัชอ่ง Selected 

 

ยา้ย Field ทีเ่ลอืกไวอ้อกจากชอ่ง Selected 

 

เลือ่นต าแหน่งของ Field ทีเ่ลอืกไวใ้นชอ่ง Selected ขึน้ไป

ดา้นบน 

 

เลือ่นต าแหน่งของ Field ทีเ่ลอืกไวใ้นชอ่ง Selected ลงมา

ดา้นลา่ง 

 

ลบ Field ทีเ่ลอืกไวใ้นชอ่ง Selected ทัง้หมด 

 

ดงึขอ้มลูทีเ่ลอืกไวไ้ปยงั Microsoft Excel 

 

ไมต่อ้งดงึขอ้มลูทีเ่ลอืกไว ้พรอ้มกบัปิดหนา้ตา่งนี้ 

 
3. พมิพ ์Symbol ของขอ้มลูทีต่อ้งการดงึขอ้มลูในชอ่ง Symbol 

4. ดับเบิล้คลกิยงั Field ทีต่อ้งการเลอืก โดย Field ทีเ่ลอืกแลว้ จะเขา้ไปอยูใ่นชอ่ง Selected  

 

 

 

 



Aspen for Windows User Guide v. 4.21 Build 0041913  May 2018 

 

ThaiQuest Limited    Helpdesk 02 651 4747 # 777    E-mail: helpdesk@thaiquest.com                                                            Page 63 of 72  

 

5. คลกิปุ่ ม Copy Link เพือ่ดงึขอ้มลูไปยงั Microsoft Excel 

 

6. ขอ้มลูทีเ่ลอืกไวจ้ะถกูสง่ไปยงั Microsoft Excel และอพัเดทแบบไดนามกิ 

 

เมน ูAspen Graphics DDE Quick Link 

ดงึขอ้มลู Quote และ Formula ไดค้ราวละหลายๆ Symbol และการเปลีย่น Symbol หรอื Field สามารถท าได ้

อยา่งงา่ยดาย เพยีงแคพ่มิพ ์Symbol หรอื Field ใหมท่ีต่อ้งการไปแทนทีไ่ดเ้ลย 

โดยการดงึขอ้มลูผา่น Aspen Graphics DDE Quick Link สามารถท าไดใ้น 2 รปูแบบ คอื 

1) Field as Column Header โดยให ้Field อยูใ่นคอลมัน ์(Column) และ Symbol อยูใ่นแถว (Row) 

2) Field as Row Header โดยให ้Field อยูใ่นแถว (Row) และ Symbol อยูใ่น คอลัมน ์(Column) 
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การดงึขอ้มลูแบบ Field as Column Header 

1. พมิพ ์Symbol ทีต่อ้งการดงึขอ้มลูไวใ้นแถวที ่2 (Row) เป็นตน้ไป 

2. พมิพช์ือ่ Field หรอื Formula ทีต่อ้งการดงึขอ้มลูไวใ้นคอลมัน ์B (Column) เป็นตน้ไป 

 

3. น าเคอรเ์ซอรเ์มาสม์าวางทีช่อ่ง A1 แลว้คลกิปุ่ มไอคอน Field as Column Header บนแถบเครือ่งมอื 

หรอืคลกิปุ่ มขวาของเมา้ส ์แลว้เลอืก Aspen Graphics DDE Quick Link > Field as Column 

Header 

  

4. หากตอ้งการเปลีย่น Symbol หรอืเปลีย่นชือ่ Field หรอื Formula ใหพ้มิพ ์Symbol หรอืชือ่ Field หรอืชือ่ 

Formula ใหมท่ีต่อ้งการเปลีย่นไปแทนทีช่ ือ่เดมิไดเ้ลย แลว้กดปุ่ ม Enter 

ตัวอยา่งเชน่ ตอ้งการเปลีย่น Symbol จาก _USDX (US Dollar Index) เป็น SET (SET Index) พมิพ ์SET 

ในชอ่ง A5แลว้กดปุ่ ม Enter (เดมิชอ่ง A5 เป็น Symbol: _USDX)  
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การดงึขอ้มลูแบบ Field as Row Header 

1. พมิพ ์Field หรอืชือ่ Formula ทีต่อ้งการดงึขอ้มลูไวใ้นแถวที ่2 (Row) เป็นตน้ไป  

2. พมิพ ์Symbol ทีต่อ้งการดงึขอ้มลูไวใ้นคอลมัน ์B (Column) เป็นตน้ไป 

 

3. น าเคอรเ์ซอรเ์มา้สม์าวางทีช่อ่ง A1 แลว้คลกิปุ่ มไอคอน Field as Row Header บนแถบเครือ่งมอื หรอื

คลกิปุ่ มขวาของเมา้ส ์แลว้เลอืก Aspen Graphics DDE Quick Link > Field as Row Header 

  

4. หากตอ้งการเปลีย่น Symbol หรอืเปลีย่นชือ่ Field หรอื Formula ใหพ้มิพ ์Symbol หรอืชือ่ Field หรอืชือ่ 

Formula ใหมท่ีต่อ้งการเปลีย่นไปแทนทีช่ ือ่เดมิไดเ้ลย แลว้กดปุ่ ม Enter 

ตัวอยา่งเชน่ ตอ้งการเปลีย่น Formula จาก MACD_DAY และ SIGNAL_DAY เป็น PCHG1W และ PCHG1M 

ตามล าดับ  พมิพ ์PCHG1W ในชอ่ง A5 (เดมิชอ่ง A5 เป็น Formula ชือ่ MACD_DAY) และพมิพ ์PCHG1M 

ในชอ่ง A6 (เดมิชอ่ง A6 เป็น Formula ชือ่ SIGNAL_DAY) 
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การดงึขอ้มลูยอ้นหลงั (History)  

การดงึขอ้มลูยอ้นหลังออกไปยงั Microsoft Excel ไดท้ัง้แบบขอ้มลูรายนาทแีละรายวัน โดยมวีธิกีาร ดังนี ้

  

1. คลกิไอคอน Create DDE Link บนแถบเครือ่งมอื 

2. จะปรากฎหนา้ตา่ง DDE Link Generator Helper Dialog ขึน้มาบนหนา้จอ 

3. คลกิทีแ่ถบ History 

 

เมน ู รายละเอยีด 

Symbol Symbol ของขอ้มลูทีต่อ้งการดงึขอ้มลู 

Interval  ความกวา้งของชว่งเวลาทีต่อ้งการวา่ตอ้งการขอ้มลูแบบรายนาท ีรายวัน หรอืราย

สปัดาห ์เป็นตน้ 

ตวัเลอืก รายละเอยีด 

Daily ขอ้มลูรายวัน 

Intraday ขอ้มลูรายนาท ีโดยระบจุ านวนนาททีีต่อ้งการในชอ่ง Span 

Tick ขอ้มลูราย 0 นาท ีหรอืแสดงทกุรายการทีเ่กดิขึน้ 

Weekly ขอ้มลูรายสปัดาห ์

Monthly ขอ้มลูรายเดอืน 

Quarterly ขอ้มลูรายไตรมาส 

Skip gaps เปิด/ปิดชอ่งวา่ง (Gap) ในชว่งวันหยดุนักขตัฤกษ์  
คลกิใหม้เีครือ่งหมายaหากตอ้งการปิด Gap  
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เมน ู รายละเอยีด 

Time Series  ก าหนดระยะเวลาทีต่อ้งการดงึขอ้มลู 

ตวัเลอืก รายละเอยีด 

Start Date พมิพว์ันทีเ่ริม่ตน้ โดยพมิพใ์นรปูแบบ MM/DD/YY เชน่ 6/15/13  

Start Time พมิพเ์วลาทีเ่ริม่ตน้ ใชส้ าหรับกรณีเลอืก Interval เป็น Intraday 

หรอื Tick เทา่นัน้ โดยพมิพเ์วลาในรปูแบบ 24 นาฬกิา เชน่ 

14:00 

End Date พมิพว์ันทีส่ ิน้สดุ โดยพมิพใ์นรปูแบบ MM/DD/YY เชน่ 6/15/13  

End Time พมิพเ์วลาทีส่ ิน้สดุ ใชส้ าหรับกรณีเลอืก Interval เป็น Intraday 

หรอื Tick เทา่นัน้ โดยพมิพเ์วลาในรปูแบบ 24 นาฬกิา เชน่ 

14:00 
Max days จ านวนวันทีต่อ้งการดงึขอ้มลู ใชส้ าหรับ Interval แบบ Daily 

เทา่นัน้ เชน่ 20 เพือ่ดงึขอ้มลูยอ้นหลัง 20 วัน 
ใชเ้มือ่ตอ้งการดงึขอ้มลูตามจ านวนวันทีร่ะบเุอาไว ้โดย Start 

Date และ End Date จะเปลีย่นไปเรือ่ยๆ เมือ่ขึน้วันใหม ่

(Rollover) 
Periods จ านวนชว่งเวลาทีต่อ้งการ ใชส้ าหรับ Interval ทกุรปูแบบ ยกเวน้ 

Daily  
ใช ้เมือ่ตอ้งการดงึขอ้มลูตามจ านวนวันทีร่ะบเุอาไว ้โดย Start 

Date และ End Date จะเปลีย่นไปเรือ่ยๆ เมือ่ขึน้วันใหม ่

(Rollover) 
Sort 

Descending 
เรยีงขอ้มลูตามวันทีใ่หมไ่ปเกา่ (Descending)  
หากตอ้งการเปลีย่นวธิกีารเรยีงเป็นจากเกา่ไปใหม ่(Ascending) 

ใหค้ลกิอกีครัง้หนึง่เพือ่ใหเ้ครือ่งหมาย a หายไป 
Display N/A 

as Blank 

ตอ้งการเปลีย่นจาก N/A เป็นชอ่งวา่งหรอืไม ่ 

คลกิใหม้เีครือ่งหมาย aเพือ่เปลีย่นจาก N/A เป็นชอ่งวา่ง 

  
 

Quote Elements 
 

เลอืก Field ทีต่อ้งการดงึขอ้มลูยอ้นหลังโดยคลกิใหม้แีถบสฟ้ีาที ่Field นัน้ๆ  

Field รายละเอยีด 

SYMBOL แสดง Symbol ของขอ้มลู 

DATE วันที ่

TIME เวลา 

HIGH ราคาสงูสดุ 

LOW ราคาต า่สดุ 

OPEN ราคาเปิด 

CLOSE ราคาปิด 

VOLUME ปรมิาณการซือ้ขาย 

OPEN INTEREST มลูคา่การซือ้ขาย (ส าหรับหุน้) หรอื  
Open Interest (ส าหรับฟิวเจอรส์) 
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ปุ่ ม รายละเอยีด 

 

ลบ Field ทีเ่ลอืกไวใ้นชอ่ง Quote Elements ทัง้หมด แถบสฟ้ีาจะหายไป 

 

ดงึขอ้มลูทีเ่ลอืกไวไ้ปยงั Microsoft Excel 

 

ไมต่อ้งดงึขอ้มลูทีเ่ลอืกไว ้พรอ้มกบัปิดหนา้ตา่งนี้ 

4. พมิพ ์Symbol ของขอ้มลูทีต่อ้งการดงึขอ้มลูในชอ่ง Symbol 

5. คลกิเลอืกชว่งเวลาของขอ้มลูกราฟทีต่อ้งการในชอ่ง Interval เชน่ Daily 

6. คลกิใหม้เีครือ่งหมายaที ่Skip gaps เพือ่ปิดชอ่งวา่งในชว่งวันหยดุนักขตัฤกษ์ 

7. ก าหนดระยะเวลาทีต่อ้งการในชอ่ง Time Series เชน่ Start Date 6/1/12 และ End Date 6/30/13  

8. หากตอ้งการเรยีงขอ้มลูตามวันทีจ่ากเกา่ไปใหม ่ใหค้ลกิทีช่อ่งหนา้ Sort Descending เพือ่เอา

เครือ่งหมาย a ออกไป 

9. เลอืก Field ทีต่อ้งการดงึขอ้มลูในชอ่ง Quote Elements ส าหรับ Field ทีไ่มต่อ้งการใหค้ลกิเมา้สท์ี ่Field 

นัน้ๆ เพือ่ใหแ้ถบสฟ้ีาหายไป 

10. คลกิปุ่ ม Copy Link เพือ่ดงึขอ้มลูไปยงั Microsoft Excel 

 

11. ขอ้มลูทีเ่ลอืกไวจ้ะถกูสง่ไปยงั Microsoft Excel และอพัเดทแบบไดนามกิ 
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การดงึขอ้มลูจากสตูรค านวณ (Formula) ออกไปยงั Microsoft Excel 

ดงึขอ้มลูจากสตูรค านวณ (Formula) ทีเ่ขยีนโดยใชฟั้งกช์นั CHART() ออกไปยงั Microsoft Excel ได ้โดยมี

วธิกีาร ดังนี ้

1. คลกิไอคอน Create DDE Link บนแถบเครือ่งมอื 

2. จะปรากฎหนา้ตา่ง DDE Link Generator Helper Dialog ขึน้มาบนหนา้จอ 

3. คลกิทีแ่ถบ Formula 

4. พมิพช์ือ่ Formula แลว้ตามดว้ย Symbol ในรปูแบบนี ้

Formula_Name (Symbol) 

5. คลกิปุ่ ม Copy Link เพือ่ดงึขอ้มลูไปยงั Microsoft Excel 

 

6. ขอ้มลูทีต่อ้งการจะถกูสง่ไปยงั Microsoft Excel และอพัเดทแบบไดนามกิ 

 

การอพัเดทขอ้มลูใน Microsoft Excel 

ขอ้มลูใน Microsoft Excel จะอพัเดทแบบไดนามกิ กต็อ่เมือ่โปรแกรม Aspen for Windows ไดถ้กูเปิดไว ้

เทา่นัน้  

 

เมือ่สรา้งไฟลท์ีด่งึขอ้มลูแบบ DDE จาก Aspen for Windows ออกมา แลว้ท าการ Save เก็บไวใ้ชค้ราว

ตอ่ไป เมือ่เปิดไฟลข์ึน้มาใหมท่กุครัง้ จะปรากฎหนา้ตา่งขอ้ความถามวา่ ตอ้งการจะอพัเดทขอ้มลูหรอืไม ่ใหค้ลกิ

ปุ่ ม Update เพือ่อพัเดทขอ้มลู  
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ตารางแสดงฟิลดท์ีด่งึขอ้มลูไปยงั Microsoft Excel ได ้

ชือ่ฟิลด ์ รายละเอยีด ประเภทขอ้มลู 

DESC ชือ่เต็มของ Symbol ขอ้มลูเกีย่วกบั Symbol 

EXPDATE วันหมดอายขุอง Warrant/DW ขอ้มลูเกีย่วกบั Symbol 

EXPIRE วันหมดอายขุอง Futures & Options (MM/DD/YY) ขอ้มลูเกีย่วกบั Symbol 

INDUSTRY กลุม่อตุสาหกรรม ขอ้มลูเกีย่วกบั Symbol 

LISTDATE วันทีเ่ร ิม่ท าการซือ้ขาย ขอ้มลูเกีย่วกบั Symbol 

SECTOR หมวดธรุกจิ ขอ้มลูเกีย่วกบั Symbol 

SYMB Symbol  ขอ้มลูเกีย่วกบั Symbol 

UNDERLYING หลกัทรัพย/์สนิทรัพยอ์า้งองิ ขอ้มลูเกีย่วกบั Symbol 

XMONTH เดอืนทีห่มดอายขุอง Futures & Options ขอ้มลูเกีย่วกบั Symbol 

BV มลูคา่ทางบญัชตีอ่หุน้ (Book value per share) ขอ้มลูพืน้ฐาน 

DPS เงนิปันผลตอ่หุน้ (Dividend per share) ขอ้มลูพืน้ฐาน 

EPS ก าไรตอ่หุน้ (Earning per share) ขอ้มลูพืน้ฐาน 

LSHARE จ านวนหุน้จดทะเบยีน (Listed shares) หน่วย: 100 หุน้ ขอ้มลูพืน้ฐาน 

MCAP มารเ์กต็แคป (Market capitalization) หน่วย: ลา้นบาท ขอ้มลูพืน้ฐาน 

MCAPR สดัสว่นมารเ์ก็ตแคปเทยีบกบัมารเ์ก็ตแคปของดชัน ี

(%MCAP) 
ขอ้มลูพืน้ฐาน 

MIMPACT Market impact ขอ้มลูพืน้ฐาน 

PBV ราคาตอ่มลูคา่ทางบญัชตีอ่หุน้ (Price per book value) ขอ้มลูพืน้ฐาน 

PERATIO อตัราสว่นราคาตอ่ก าไรตอ่หุน้ (Price earnings ratio) ขอ้มลูพืน้ฐาน 

YLD อตัราสว่นเงนิปันผลตอบแทน (Dividend Yield) หน่วย: % ขอ้มลูพืน้ฐาน 

ASK ราคาเสนอขายล าดบัที ่1 (Offer 1) ขอ้มลูราคา 

ASK2 ราคาเสนอขายล าดบัที ่2 (Offer 2) ขอ้มลูราคา 

ASK3 ราคาเสนอขายล าดบัที ่3 (Offer 3) ขอ้มลูราคา 

ASK4 ราคาเสนอขายล าดบัที ่4 (Offer 4) ขอ้มลูราคา 

ASK5 ราคาเสนอขายล าดบัที ่5 (Offer 5) ขอ้มลูราคา 

ASKSIZE ปรมิาณเสนอขายล าดบัที ่1 (Offer Vol. 1) ขอ้มลูราคา 

ASKSIZE2 ปรมิาณเสนอขายล าดบัที ่2 (Offer Vol. 2) ขอ้มลูราคา 

ASKSIZE2 ปรมิาณเสนอขายล าดบัที ่2 (Offer Vol. 2) ขอ้มลูราคา 

ASKSIZE3 ปรมิาณเสนอขายล าดบัที ่3 (Offer Vol. 3) ขอ้มลูราคา 

ASKSIZE4 ปรมิาณเสนอขายล าดบัที ่4 (Offer Vol. 4) ขอ้มลูราคา 

ASKSIZE5 ปรมิาณเสนอขายล าดบัที ่5 (Offer Vol. 5) ขอ้มลูราคา 

BETA คา่เบตา้ของหุน้รายตวั (ขอ้มลูจาก ตลท.) ขอ้มลูราคา 

BID ราคาเสนอซือ้ล าดับที ่1 (Bid 1) ขอ้มลูราคา 

BID2 ราคาเสนอซือ้ล าดับที ่2 (Bid 2) ขอ้มลูราคา 

BID3 ราคาเสนอซือ้ล าดับที ่3 (Bid 3) ขอ้มลูราคา 

BID4 ราคาเสนอซือ้ล าดับที ่4 (Bid 4) ขอ้มลูราคา 

BID5 ราคาเสนอซือ้ล าดับที ่5 (Bid 5) ขอ้มลูราคา 
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ชือ่ฟิลด ์ รายละเอยีด ประเภทขอ้มลู 

BIDSIZE ปรมิาณเสนอซือ้ล าดับที ่1 (Bid Vol. 1) ขอ้มลูราคา 

BIDSIZE2 ปรมิาณเสนอซือ้ล าดับที ่2 (Bid Vol. 2) ขอ้มลูราคา 

BIDSIZE3 ปรมิาณเสนอซือ้ล าดับที ่3 (Bid Vol. 3) ขอ้มลูราคา 

BIDSIZE4 ปรมิาณเสนอซือ้ล าดับที ่4 (Bid Vol. 4) ขอ้มลูราคา 

BIDSIZE5 ปรมิาณเสนอซือ้ล าดับที ่5 (Bid Vol. 5) ขอ้มลูราคา 

BUYVOLUME ปรมิาณจากฝ่ังซือ้ (Buy Volume) ขอ้มลูราคา 

CEIL ราคา Ceiling ขอ้มลูราคา 

CHANGE คา่ Change เมือ่เทยีบกบัราคาปิดวันกอ่นหนา้ ขอ้มลูราคา 

CLOSE1M ราคาปิดในรอบ 1 เดอืนทีแ่ลว้ (คา่ของวันกอ่น) ขอ้มลูราคา 

CLOSE1W ราคาปิดในรอบ 1 สปัดาหท์ีแ่ลว้ (คา่ของวันกอ่น) ขอ้มลูราคา 

CLOSE1Y ราคาปิดในรอบ 1 ปีทีแ่ลว้ (คา่ของวันกอ่น) ขอ้มลูราคา 

CLOSE3M ราคาปิดในรอบ 3 เดอืนทีแ่ลว้ (คา่ของวันกอ่น) ขอ้มลูราคา 

CLOSE6M ราคาปิดในรอบ 6 เดอืนทีแ่ลว้ (คา่ของวันกอ่น) ขอ้มลูราคา 

EXPRICE ราคาใชส้ทิธิ ์ ขอ้มลูราคา 

EXRATIO อตัราการใชส้ทิธิ ์ ขอ้มลูราคา 

FFLOAT คา่ฟรโีฟลท (Free Float) ขอ้มลูราคา 

FLOR ราคา Floor ขอ้มลูราคา 

HI52W ราคาสงูสดุในรอบ 52 สปัดาห ์(คา่ของวันกอ่น) ขอ้มลูราคา 

HIGH ราคาสงูสดุของวัน ขอ้มลูราคา 

LAST ราคาลา่สดุ (รวมราคา Bid และ Offer ดว้ย) ขอ้มลูราคา 

LO52W ราคาต า่สดุในรอบ 52 สปัดาห ์(คา่ของวันกอ่น) ขอ้มลูราคา 

LOW ราคาต า่สดุของวัน ขอ้มลูราคา 

LTDATE วันท าการซือ้ขายสดุทา้ยของ DW ขอ้มลูราคา 

NET คา่ Change เมือ่เทยีบกบัราคาปิดวันกอ่นหนา้ ขอ้มลูราคา 

OPEN ราคาเปิดของวัน ขอ้มลูราคา 

PCTCHG % การเปลีย่นแปลงวันนี ้(คา่ของวันนี)้  ขอ้มลูราคา 

PCTCHG1M % การเปลีย่นแปลงในรอบ 1 เดอืน (คา่ของวันกอ่น) ขอ้มลูราคา 

PCTCHG1W % การเปลีย่นแปลงในรอบ 1 สปัดาห ์(คา่ของวันกอ่น)  ขอ้มลูราคา 

PCTCHG1Y % การเปลีย่นแปลงในรอบ 1 ปี (คา่ของวันกอ่น) ขอ้มลูราคา 

PCTCHG3M % การเปลีย่นแปลงในรอบ 3 เดอืน (คา่ของวันกอ่น) ขอ้มลูราคา 

PCTCHG6M % การเปลีย่นแปลงในรอบ 6 เดอืน (คา่ของวันกอ่น) ขอ้มลูราคา 

PREV ราคาปิดวันกอ่น ขอ้มลูราคา 

PREVAVGVOL5D คา่เฉลีย่ 5 วันของ Volume (คา่ของวันกอ่น) ขอ้มลูราคา 

PREVOI Open Interest ของวันกอ่น ขอ้มลูราคา 

PROJECTED ราคา Projected  ขอ้มลูราคา 

PROJVOL ปรมิาณซือ้ขายในชว่ง Projected ขอ้มลูราคา 

RECENT ราคาเทรดลา่สดุ ขอ้มลูราคา 

SELLVOLUME ปรมิาณจากฝ่ังขาย (Sell Volume) ขอ้มลูราคา 

TIME เวลาเทรดลา่สดุ ขอ้มลูราคา 
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ชือ่ฟิลด ์ รายละเอยีด ประเภทขอ้มลู 

TRADE ราคาเทรดลา่สดุ ขอ้มลูราคา 

TRADESIDE ฝ่ังของราคาเทรดวา่มาจากฝ่ังซือ้ (B) หรอืฝ่ังขาย(S)  ขอ้มลูราคา 

TRADESIZE ปรมิาณของรายการเทรดลา่สดุ  ขอ้มลูราคา 

VALUE มลูคา่การซือ้ขายสะสม  ขอ้มลูราคา 

VOLUME ปรมิาณการซือ้ขายสะสม  ขอ้มลูราคา 

VWAP ราคาเฉลีย่แบบ Volume Weighted Average ขอ้มลูราคา 

 


